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Product Basics

See these sections to learn about the basic features of your product.

Using the Control Panel

Product Parts Locations

Using Eco Mode

Epson Connect Solutions for Smartphones, Tablets, and More
Using Google Cloud Print

Setting Up Google Cloud Print on a Chromebook

Android Printing Using the Epson Print Enabler

Using Fire OS Printing

Using Epson Print and Scan App with Windows Tablets

Using the Control Panel
See these sections to learn about the control panel and select control panel settings.

Control Panel Buttons and Lights

Setting a Password and Locking the Control Panel
Changing LCD Screen Language

Adjusting the Screen Contrast

Parent topic: Product Basics

Control Panel Buttons and Lights

Paper Setup @ Stop
| —
o (o)
()
Wim Error Data Back
00 @
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The LCD screen

N OO O A WN

Status Icons

The O power button and light
The DIy Paper Setup button
The Error and Data lights

The 3 Back button
The arrow buttons and the OK button
The @ Stop button

Parent topic: Using the Control Panel

Status Icons

Status icons may be displayed on the LCD screen depending on the product's status.

Icons Description
There is no Ethernet connection.
s

An Ethernet connection has been established.

A Wi-Fi network error has occurred or the product is searching for a connection.

':’Elﬂ'ﬂ

A Wi-Fi connection has been established. The number of bars indicates the
connection's signal strength.

= An Ad hoc connection has been established.
B

— A Wi-Fi Direct mode connection has been established.
=D

-':_-_"-:;F_ A Simple AP mode connection has been established.
.

Cl=1=) One of the Eco Mode settings is enabled.

Parent topic: Control Panel Buttons and Lights
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Setting a Password and Locking the Control Panel
You can set an administrator password to lock the following control panel settings:
» System Administration Setup settings
* Eco Mode settings
When the control panel is locked, you must enter the password to access any of the locked settings.
1. Press the up and down arrow buttons, select Menu, and press the OK button.
You see a screen like this:

Menu
Ik Level

@D Proceed

2. Press the down arrow button, select Admin Settings, and press the OK button.
3. Select Admin Password and press the OK button.
4. Select Register and press the OK button.

You see a screen like this:

Acmin Password
Friter Mew Password.

K0 Mowve cursor

5. Use the control panel buttons to enter a password and press the OK button.
6. Enter your password again to confirm.
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7. Press the OK button.
8. Use the arrow buttons to select Lock Setting and press the OK button.
9. Select On and press the OK button.

Note: If you forget your password, contact Epson support for assistance.

Entering Characters on the LCD Screen
Parent topic: Using the Control Panel
Entering Characters on the LCD Screen
Follow these guidelines to enter characters for passwords and other settings.

My_home's WiFi
Friter Password

K0 Mowve cursor

* To enter letters or symbols, press the up or down arrow buttons to scroll through characters, and press
the right arrow button to select one.

« To enter numbers or change the case of letters, press the & Stop button.
» To delete the previous character, press the left arrow button.

» To enter a space, press the right arrow button.

Parent topic: Setting a Password and Locking the Control Panel

Changing LCD Screen Language

You can change the language used on the LCD screen.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the up or down arrow buttons, select Menu, and press the OK button.
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2. Press the down arrow button, select System Administration, and press the OK button. Enter the
administrator password, if necessary.

You see a screen like this:

System Admninistration
EFrinter Settings

(I3 Proceed

3. Press the down arrow button, select Common Settings, and press the OK button.
4. Press the down arrow button, select Language, and press the OK button.

5. Select a language and press the OK button.

Parent topic: Using the Control Panel

Adjusting the Screen Contrast
You can adjust the contrast of the LCD screen.
1. Press the up or down arrow buttons, select Menu, and press the OK button.

2. Press the down arrow button, select System Administration, and press the OK button. Enter the
administrator password, if necessary.

You see a screen like this:

Systen Adninistration
EFrinter Settings

(I3 Proceed
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Select Common Settings and press the OK button.

Select LCD Contrast and press the OK button.

Press the up or down arrow buttons to adjust the screen contrast.
Press the OK button to exit.

Parent topic: Using the Control Panel

o o bk w

Product Parts Locations

See these sections to identify the parts on your product.

Printer Parts - Top
Printer Parts - Inside
Printer Parts - Back

Parent topic: Product Basics

Printer Parts - Top
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Rear sheet feeder edge guides
Rear paper support

Rear paper feed cover

Output tray

Cassette edge guides

o o~ WDN -

Output tray extension and paper stopper

1 Paper cassette 1

2  Paper cassette unit (optional)
3  Paper cassette 2 (optional)

Parent topic: Product Parts Locations
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Printer Parts - Inside

1 Ink cartridge holder
2  Print head (do not remove)
3  Front cover (opened)

Parent topic: Product Parts Locations

Printer Parts - Back

1 USB port
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Ethernet LAN port
Service port
Maintenance box
Rear cover

AC inlet

o o0~ W DN

Parent topic: Product Parts Locations

Using Eco Mode

Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period
of time. You can make the time period shorter and select other options to save energy and resources.

Changing the Eco Settings
Changing the Sleep Timer Settings
Changing the Power Off Timer Settings

Parent topic: Product Basics

Changing the Eco Settings

You can use the product control panel to change the Eco settings.

Note: The Sleep Timer setting in Eco Mode overrides the Sleep Timer setting in Common Settings. This
setting can be locked by an administrator. If you cannot access or change this setting, contact your
administrator for assistance.

Press the up or down arrow buttons, select Menu, and press the OK button.

2. Press the up or down arrow buttons, select System Administration, and press the OK button. Enter
the administrator password, if necessary.

3. Press the up or down arrow buttons, select Eco Mode, and press the OK button.

20



You see a screen like this:

Systen Administration

Eco Mode
BOff
I3 Proceed

Select On and press the OK button.
Press the up arrow button.

Change settings as necessary.
Press the OK button to exit.

N o g bk

You see the icon on the LCD screen to indicate that Eco settings are enabled.
Parent topic: Using Eco Mode

Changing the Sleep Timer Settings

You can adjust the time period before your product enters sleep mode and turns off the LCD screen.

Note: The Sleep Timer setting in Eco Mode overrides the Sleep Timer setting in Common Settings. This
setting can be locked by an administrator. If you cannot access or change this setting, contact your
administrator for assistance.

Press the up or down arrow buttons, select Menu, and press the OK button.

2. Press the up or down arrow buttons, select System Administration, and press the OK button. Enter
the administrator password, if necessary.

3. Press the down arrow button, select Common Settings, and press the OK button.
4. Press the down arrow button, select Sleep Timer, and press the OK button.
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You see a screen like this:

Lonmon Settings
Eoleep Tiner
2 000minutes

5. Press the up or down arrow buttons to increase or reduce the number of minutes.
6. Press the left or right arrow buttons to move the cursor.

7. Press the OK button.

Parent topic: Using Eco Mode

Changing the Power Off Timer Settings

You can have the product turn off automatically if it is not used for a specified period of time.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the up or down arrow buttons, select Menu, and press the OK button.

2. Press the down arrow button, select System Administration, and press the OK button. Enter the
administrator password, if necessary.

You see a screen like this:

System Admninistration
gFrinter Settings

(I3 Proceed
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3. Press the down arrow button, select Common Settings, and press the OK button.

4. Press the down arrow button, select Power Off Timer, and press the OK button.

5. Select a time period between 30minutes and 12h (12 hours), and press the OK button.
Parent topic: Using Eco Mode

Epson Connect Solutions for Smartphones, Tablets, and More

Use your smartphone, tablet, or computer to print documents, photos, emails, and web pages from your
home, office, or even across the globe.

Using Epson Email Print

Using the Epson iPrint Mobile App

Using the Epson Creative Print Mobile App
Using Epson Remote Print

Parent topic: Product Basics

Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the
attachments will print automatically.

1. Connect your product to your network. See the link below.

2. If you did not already set up Email Print when you installed your product software, visit
epsonconnect.com to learn more about Email Print, create your Epson Connect account, and
register your product to the Epson Connect service.

3. Now you are ready to send and print emails to your product's Email Print address.

Note: Go to epsonconnect.com and log into your Epson connect account to personalize your product's
email, adjust print settings, and set up other Epson Connect services.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking
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Using the Epson iPrint Mobile App

Use this free Apple and Android app to print with networked Epson products. Epson iPrint lets you print
PDFs, Microsoft Office documents, photos, and web pages from your device or from popular cloud
services such as Box, Dropbox, Evernote, Google Drive, or Microsoft OneDrive.

1. Connect your product to your wireless network. See the link below.

2. Visit epson.com/connect to learn more about Epson iPrint and check the compatibility of your mobile
device.

3. Download Epson iPrint from the Apple App Store or Google Play.

4. Connect your mobile device to the same wireless network as your product.
5. Open Epson iPrint and select your Epson product.

Now you are ready to print with your mobile device and your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using the Epson Creative Print Mobile App
Use this free Apple and Android app to do the following:
» Access and print your Facebook photos
» Create custom greeting cards and stationery
* Print onto CD/DVDs
» Turn photos into coloring book templates
1. Connect your product to your wireless network. See the link below.

2. Visit epson.com/connect to learn more about Epson Creative Print and check the compatibility of
your mobile device and your Epson product.

3. Download Epson Creative Print from the Apple App Store or Google Play.

4. Connect your mobile device to the same wireless network that your product is using.
5. Open Epson Creative Print.

Now you are ready to get creative with your mobile device and your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
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Related topics
Wi-Fi or Wired Networking

Using Epson Remote Print

With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson
Email-enabled product anywhere in the world.

1.
2.

Connect your Epson product to your wireless network. See the link below.

If you did not already set up an Epson Connect account when you installed your product software,
visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address.

Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print
Driver software.

Download and install the Remote Print software.
Enter the email address and optional access key of your Epson product during Remote Print setup.

Now you are ready to print remotely. Select the print command in your laptop or desktop computer
application and choose the Remote Print option for your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.

1.
2.
3.

Connect your Epson product to your wireless network. See the link below.
Note your product's IP address by checking your network status. See the link below.

Connect your computer or your Apple or Android device to the same wireless network as your Epson
product.

Enter your product's IP address into the address bar of a web browser.
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5. Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

6. Click Register.
7. Select the checkbox to agree to the Usage Advisory and click Next.
8. Click OK to launch the sign-in page.

A separate browser window opens.

9. Enter your Google Account username and password and click Sign in, or, if you don't have an
account, click Sign up for a new Google Account and follow the on-screen instructions.

10. Click Finish printer registration to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with Internet access. Visit Epson Support for more information on
using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Setting Up Google Cloud Print on a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

Note: See your Chromebook's documentation for details on connecting to a network.

3. Do one of the following:

» Click Add to Cloud Print in the notification that appears in the corner of your Chromebook
screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

26


http://www.epson.com/cgi-bin/Store/support/supDetail.jsp?sku=GPRINT
http://www.google.com/cloudprint/learn/index.html
http://www.google.com/cloudprint/learn/apps.html

» Open a web browser and enter chrome://devices in the address bar. Skip to step 4.
* If you see a registration confirmation screen instead, click Register.

4. Click Add Device.

5. Click the Register button that appears next to your product.

6. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation
message.

7. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and
print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, iPhone,
or Android phone with Internet access. Visit Epson Support for more information on using Google Cloud
Print, or the Google Cloud Print website for a list of supported apps

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Android Printing Using the Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone
or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson
product and print.

1. Connect your Epson product to your wireless network. See the link below.

On your Android device, download the Epson Print Enabler plug-in from Google Play.
Go to settings on your Android device, select printers, and enable the Epson plug-in.
Connect your Android device to the same wireless network as your product.

o &~ on

Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu
icon and print whatever is on the screen.

Note: If you do not see your product, tap All Printers and select your product.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking
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Using Fire OS Printing

You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product.
There is no software to download, no drivers to install, and no cables to connect. With just a few taps in
Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson
product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Amazon device to the same wireless network as your product.

3. Now you are ready to print. From your Amazon application, tap the print option and select your
product to print whatever is on the screen.

Note: If you see a message telling you that a plug-in is required, tap OK and tap Download. If your
Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria
Print Service app to print.

Visit epson.com/connect to learn more about Fire OS Printing (one of many Epson Connect Partner
Solutions) and check the compatibility of your mobile device.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Using Epson Print and Scan App with Windows Tablets

You can use this free app to print photos and scan from your Windows (Windows 8 or higher) Surface
RT or Pro tablet with networked Epson products. Epson Print and Scan App allows you to scan and
capture images right to your tablet or to Microsoft OneDrive.

Note: The Epson Print and Scan App does not support Windows 10 Mobile printing.

Connect your Epson product to your wireless network. See the link below.
Download Epson Print and Scan App from the Microsoft Windows Store.
Connect your Windows tablet to the same wireless network as your product.
Open Epson Print and Scan App and select your Epson product.

Now you are ready to print photos or scan.

b=

Visit epson.com/connect to learn more about Epson Print and Scan App.
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Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking
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Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.
Wi-Fi Infrastructure Mode Setup

Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
2  Wireless router or access point
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3 Computer with a wireless interface
4 Computer

5 Internet

6

Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings From the Control Panel
Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings From the Control Panel
You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software. The installer program guides you through network setup.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

1. Press the up or down arrow buttons, select Wi-Fi Setup, and press the OK button.
You see this screen:

Wi-Fi Setup
Bli-Fi Setup Vizard

2. Select Wi-Fi Setup Wizard and press the OK button.

Note: If you need to disable the wireless network to set up your product on an Ethernet network,
press the down arrow button, select Disable Wi-Fi, and press the OK button. Then follow the
instructions on changing to a wired network connection in this guide.
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3. Select the name of your wireless network and press the OK button.

Note: To enter the wireless network name manually, select Other Networks and press the OK
button. Use the printer's buttons to enter your network name.

4. Enter your wireless password using the control panel buttons.

My_home's: WiF
Friter Password

K0 Move cursor

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

» To enter letters or symbols, press the up or down arrow buttons to scroll through characters, and
press the right arrow button to select one.

« To enter numbers or change the case of letters, press the & Stop button.
* To delete the previous character, press the left arrow button.
* To enter a space, press the right arrow button.
5. Press the OK button when you're finished entering your password.
6. Confirm the displayed network settings and press the OK button to save them.

Note: If you need to change a setting, press the 5 Back button.

7. If you want to print a network setup report, press the down arrow button, select Print connection
report, and press the OK button. (Otherwise, press the OK button.)

£

If the network connection is successful, the Wi-Fi icon (
the LCD screen.

Parent topic: Wi-Fi Infrastructure Mode Setup

) appears in the upper-right corner of

32



Related tasks
Entering Characters on the LCD Screen

Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point.

£ (ks

1 Epson product
2  Computer with a wireless interface
3  Other wireless device

Your product automatically selects one of these modes to communicate with your computer or device:

Access point mode
If your product is not already connected to a wireless network, it enters access point mode and the
product itself acts as the network access point for up to 4 devices. When operating in this mode, your
product displays an AP connection symbol on the LCD screen.

Peer-to-peer mode
If your product is already connected to a wireless network, it enters peer-to-peer mode and
disconnects from any other networks. This also disables any other product features requiring access
to the Internet. When operating in this mode, your product displays a Direct or D connection symbol
on the LCD screen.

Note: To disconnect a peer-to-peer mode connection, release the connection to your product from
your computer or other device. Your product will reconnect to the previously used network.
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Enabling Wi-Fi Direct Mode
Parent topic: Wi-Fi or Wired Networking

Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and a computer
or other devices without a wireless router or access point.

Note: You may need to enable the Wi-Fi Direct setting in the Advanced Settings menu before you can
enable Wi-Fi Direct mode.

1. Press the up or down arrow buttons, select Wi-Fi Setup, and press the OK button.
You see this screen:

Wi-Fi Setup
BIi-Fi Setup Wizard

Press the down arrow button, select Wi-Fi Direct Setup, and press the OK button.
Press the down arrow button, select Connection Setup, and press the OK button.
Press the down arrow button, select Change Password, and press the OK button.
Press the OK button.

o &~ on

Note: If you have already connected devices or computers to your product via Wi-Fi Direct, they will
be disconnected when you change the password.
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6. Enter a Wi-Fi Direct password using the control panel buttons.

Note: Your password must be at least 8 and no more than 22 characters long.

My_home's: WiF
Friter Password

KD Mowve cursor

* To enter letters or symbols, press the up or down arrow buttons to scroll through characters, and
press the right arrow button to select one.

* To enter numbers or change the case of letters, press the @ Stop button.
* To delete the previous character, press the left arrow button.
* To enter a space, press the right arrow button.
7. Press the OK button when you're finished entering your password.
8. Press the up arrow button.
You see this screen:

Wi-Fi Direct Setup
Please chioose the foll

(I3 Proceed

9. Press the OK button to view the SSID (Wi-Fi network name) and password.

10. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the
LCD screen, and enter the password shown.
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11. Press the 3 Back button to return to the Home screen.
B
You see the *#&F connection symbol on the LCD screen and should be able to print directly to your
product from your computer or device.

o
Note: Ifthe *&F connection symbol is not displayed on the LCD screen, Wi-Fi Direct mode is not
enabled. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup

Related tasks
Entering Characters on the LCD Screen

Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.

1. Press the down arrow button, select Wi-Fi Setup, and press the OK button.
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You see this screen:

Wi-Fi Setup
BIi-Fi Setup Wizard

2. Press the down arrow button, select Push Button Setup (WPS), and press the OK button.
3. Follow the instructions on the LCD screen to complete WPS setup.
Press the 3 Back button to return to the Home screen.

If the network connection is successful, the Wi-Fi icon (% ) will appear in the upper-right corner of
the LCD screen.

Parent topic: Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

1. Press the up or down arrow buttons, select Menu, and press the OK button.
You see this screen:

Menu
Ink Lewel

@D Proceed
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2. Press the down arrow button, select Network Status, and press the OK button.
3. Press the down arrow button, select Wi-Fi/Network Status, and press the OK button.
You see a screen like this:

Wi-Fi/Network Status
Printer Name
M=-T990-030000

@ Print

4. Press the OK button to print the network status sheet.

5. Press the up arrow button to begin printing the network status sheet.

Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi or Wired Networking

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility

Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router

Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

Note: For more information on the Web Config utility, see the Administrator's Guide.

38


https://files.support.epson.com/docid/cpd4/cpd41038/index.html

1. Print a network status sheet.
Locate the IP address for your product that is listed on the network status sheet.

3. On a computer or other device connected to the same network as your product, open a web
browser.

4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections

Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.

3. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Related concepts
Uninstall Your Product Software

Changing a Wi-Fi Connection to a Wired Network Connection

If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.

1. Disable your product's Wi-Fi features.

Connect one end of an Ethernet network cable to the product's LAN port.
Connect the other end to any available LAN port on your router or access point.
Uninstall your product software.

Download and install your product software from the Epson website.

Follow the on-screen instructions to install the software.

No o bk b

When you see the Select Your Connection screen, select Wired network connection.
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8. If you see a Select Setup Option screen, select Set up printer for the first time.
9. Continue following the rest of the on-screen instructions.
Parent topic: Changing or Updating Network Connections

Related tasks
Disabling Wi-Fi Features

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

1. Do one of the following:
* Windows: Uninstall your product software.

* OS X: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Related concepts
Uninstall Your Product Software

Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Press the down arrow button, select Wi-Fi Setup, and press the OK button.
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You see this screen:

Wi-Fi Setup
BIi-Fi Setup Wizard

2. Press the down arrow button, select Disable Wi-Fi, and press the OK button.
3. Press the up arrow button to disable Wi-Fi.

4. Press the OK button when complete.

Parent topic: Changing or Updating Network Connections
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Enabling Epson Universal Print Driver (PCL) or PostScript
Printing
Before enabling Epson Universal Print Driver (PCL) or PostScript printing on your product, make sure
you have installed the software as described on the Start Here sheet.

Installing the Epson Universal Print Driver - Windows
Installing the PostScript (PS3) Printer Software - Windows
Installing the PostScript (PS3) Printer Software - OS X
Selecting PDL (Page Description Language) Settings
Selecting Printer Language and Interface Settings

Installing the Epson Universal Print Driver - Windows

The Epson Universal Print Driver supports multiple printer languages, such as PCL and ESC/P-R, and
can be installed on a Windows computer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software. Depending on your model, not all printer languages may be supported.

1. Download the EPSON Universal Print Driver from epson.com/support/wfm5194downloads.
2. Double-click the downloaded package.
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3. Follow the on-screen instructions until you see this screen:

EPSOM Printer Uitilities Setup

Detect the printer, and automatically configure the port.
Is $he printer connecied via a network 7

(®)Yea: Histwork connectiar]

Saarch aplions ..

et () No: USE connection

[[] Set Defaut of Frinter Corbrol Language to PCLE

OK Abort

4. Select Yes: Network connection and click OK.

Note: Select the Set Default of Printer Control Language to PCL6 checkbox if you want to set the
default printer language to PCL6. Leave this option deselected to set the printer language to ESC/P-
R. (You can change this setting later as needed.)
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After the software finishes searching for products, you see a screen like this:

! EPS0OM Printer LHilities Setup 7 ®
(%) Add EPSON Liniwansal Print Driver
() Add fiound perters
Seladd & pad ta carmect & prrier
Salact from found panters o
Found Printers:
Mode! flame P Addness MAL Addness Location
WP XG0 192 16813000 DO2GABFREDIC
V- 20000 152 1681000 ACTRIEICE0RC Unberienan
W= 2000 182 1681000 DOZEABFFISED Linkncwm
< >
£ Set as defaull prnter Diaplay Setngs
= ]

5. Do one of the following:

* If you are installing one product, make sure Add EPSON Universal Print Driver is selected and
continue with the next step.

+ If you are installing more than one product, select Add found printers and go to step 9.

Note: You can customize and filter your product search results by clicking Display Settings.
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Open the Select a port to connect a printer menu and select an existing printer port, if necessary.
Otherwise, skip this option to create a new port automatically.

Select the product you want to install from the Found Printers list.

Note: Deselect the Set as default printer checkbox if you do not want the product to be set as your
default printer.

Click OK, then skip the remaining steps.

If you are installing more than one product, select the products from the Found Printers list and click
Add to Printer Folder.

! EPSOM Printer Lialities Setup 7 by

() Add EPSOMN Urievaraal Print Driver
(%) Add fourd perters

Salect prirters from the falowing list, amd then dick the "Add to Prinber Falder” bufton . (You can
select mubple printers from the: list )

Found Printers:
Madel Mame P Address MAL Address Locaton il
WF- X000 192 16813000 ACB2E2BET
WF-2000 152 16813000 B4EBBC2551CE
WE- 00 192 1681000 EAEBBCTANFID
WIP-X0H 192 16813000 DO2GABFREDIC
WF-20000 152 168110004 AC1EMEICH05C
ET- X0 192168 130001 40244048341
REAE A0 88 4 M ABECSERM v
L4 *
Ak tio Printer Folder | Diaplay Settings
Printers to be addsd
Mam= of added prinler IF Address

[ ERSOM Universal Print Dierver WF- 30004 192,168, 1. 3000
[C] EPSOM Universal Print Detver WF-1000 152.168.1.3060C

indio Edit

Salerd & prnter from ihe s 1o 28 § & the delasuk prinber

Help Aot 0K Back
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The selected products appear in the lower section of the screen.
10. Select the checkbox next to the product you want to make your default printer, if necessary.
11. Click OK.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Installing the PostScript (PS3) Printer Software - Windows

If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer
software before you can adjust the print settings and print to your network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

1. Download the Drivers and Utilities Combo Package - PS3 PostScript from
epson.com/support/wfm5194downloads.

Double-click the downloaded package.
Click OK.

Click Accept.

Click Install.

I

. Click Next and follow the on-screen instructions.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Installing the PostScript (PS3) Printer Software - OS X

If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer
software before you can adjust the print settings and print to your network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

1. Download the Drivers and Utilities Combo Package - PS3 PostScript from
epson.com/support/wfm5194downloads.

2. Double-click the downloaded package.

3. Double-click EPSON.
Click Continue on the next two screens.
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Click Agree.
Click Install.
If necessary, enter the administrator password.

® N o O

Click Start and follow the on-screen instructions.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Selecting PDL (Page Description Language) Settings

You can select settings for PCL and PostScript printing using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the arrow buttons to select Menu and press the OK button.
You see a screen like this:

Menu
Ik Level

I Proceed

2. Select System Administration and press the OK button. Enter the administrator password, if
necessary.

3. Select Universal Print Settings and press the OK button.
4. Select PDL Print Configuration and press the OK button.
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You see a screen like this:

FOL Print Configurat...

BLommaon Settings

Proceed

5. Select an option, then select the settings you want to use.

PDL Print Configuration Options

Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

PDL Print Configuration Options

Select the PDL Print Configuration options you want to use for PCL or PostScript printing.

option

PDL Print Configuration

Available
settings

Description

Common Settings

Paper Size Various sizes Sets the default paper size for PCL or PostScript
printing.
Paper Type Various paper Sets the default paper type for PCL or PostScript
types printing.
Orientation Portrait Sets the default orientation for PCL or PostScript
printing.
Landscape
Quality Draft Sets the quality for PCL or PostScript printing.
Standard
Best
Ink Save Mode On/Off Saves ink by reducing print density.
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PDL Print Configuration
option

Available
settings

Description

Print Order

Last Page on
Top

Starts printing from the first page of a file.

First Page on
Top

Starts printing from the last page of a file.

Number of Copies 1 to 999 Selects the number of copies to print.

Binding Margin Left Edge Specifies the binding edge for double-sided documents.
Top Edge

Auto Paper Ejection On/Off Ejects paper automatically when printing is stopped

during a print job.

2-Sided Printing On/Off Selects duplex printing.

PCL Menu

Font Source Resident Uses a font preinstalled on the printer.
Download Uses a font you have downloaded.

Font Number 1to 111 Selects the default font number for the default font

source.

Pitch

0.44 to 99.99 cpi

Selects the default font pitch if the font is scalable and
fixed-pitch (availability depends on font source and
number settings).

Height

4.00 t0 999.75 pt

Selects the default font height if the font is scalable and
proportional (availability depends on font source and
number settings).

Symbol Set

Various

Selects the default symbol set. If the selected font is not
available for the selected symbol set, the font source
and number are replaced with IBM-US (the default
setting).

Form

5to 128 lines

Sets the number of lines for the selected paper size and
orientation. Changes the line spacing (VMI) stored in
the printer. Later changes in page size or orientation
cause changes in the Form value based on the stored
VMI.
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PDL Print Configuration | Available Description
option settings
CR Function CR Selects the line feed command when printing with a
CR+LF driver from a specific operating system.
LF Function LF
CR+LF
Paper Source Assign 4 Makes the paper source select command compatible
with HP LaserJet 4
4K Makes the paper source select command compatible
with HP LaserJet 4000, 5000, and 8000
58 Makes the paper source select command compatible
with HP LaserJet 5S
PS3 Menu
Error Sheet On/Off Prints a sheet showing the status when errors occur
during PostScript or PDF printing.
Binary On/Off Enable when printing files that contain binary images

(available when the product is connected to the
network). Allows you to print binary images even if the
driver is set to ASCII.

PDF Page Size

Various sizes

Selects the paper size when printing a PDF file. If Auto
is selected, the paper size is determined based on the
size of the first page.

Parent topic: Selecting PDL (Page Description Language) Settings

Selecting Printer Language and Interface Settings
You can select printer language and interface settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the arrow buttons to select Menu and press the OK button.




You see a screen like this:

Menu
Nk Lewvel

@@ Proceed

2. Select System Administration and press the OK button. Enter the administrator password, if
necessary.

3. Select Printer Settings.
You see a screen like this:

Printer Settings
BPaper Source Setting

(I3 Proceed

4. Select the Printing Language and other settings you want to use.
Printer Language and Interface Options
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Printer Language and Interface Options
Select the settings you want to use.
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Printer Settings option [ Available Description
settings
USB I/F Timeout Setting [ 0.5 to 300 Specify the length of time before ending USB
seconds communication from a computer using the PCL or
PostScript driver. This setting is necessary to avoid
endless USB communication.
Printing Language Auto Select the language for the USB or network interface.
PCL
PS3
PDF
PC Connection via USB | Enable Select whether to allow USB communication with the
Disable product.

Parent topic: Selecting Printer Language and Interface Settings

52




Loading Paper

Before you print, load paper for the type of printing you will do.
Note: Load only plain paper when printing with the PCL or PostScript (PS3) printer software.

Loading Paper for Documents in the Cassette

Loading Paper or Envelopes in the Rear Paper Feed Slot
Paper Loading Capacity

Available Epson Papers

Selecting the Paper Settings for Each Source - Control Panel
Selecting Default Paper Settings - Administrator

Installing and Enabling the Optional Second Paper Cassette

Loading Paper for Documents in the Cassette
You can print documents on a variety of paper types and sizes.
1. Close the paper stopper and output tray, if necessary.
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2. Pull out the paper cassette.

3. Slide the edge guides outward.
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Note: If you are using legal-size paper or larger, squeeze the tab and extend the paper cassette.
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5. Load a stack of paper, printable side down, against the edge guide as shown.

W gwp o

Note: Make sure the paper is loaded against the edge guide and not sticking out from the end of the
cassette.

6. Slide the edge guides against the paper, but not too tightly.

Note: Make sure the paper fits beneath the top edges of the guides.

Caution: To prevent paper feeding problems, make sure you do not load too much paper in the
cassette.
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7. Gently insert the paper cassette.

Note: The paper may slide forward slightly as you insert the cassette. This is normal.

8. When prompted by the product's LCD screen, select the size and type of the paper you just loaded
and press the OK button.

9. Extend the output tray and open the paper stopper.
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Note: If you are using legal-size or longer paper, do not open the paper stopper. Do not remove or
insert the paper cassette during printing.

Always follow these paper loading guidelines:
* Load only the recommended number of sheets.
* Load paper short edge first, no matter which way your document faces.
* Load the printable side facedown.
* Load letterhead or pre-printed paper top edge first.
* Do not load paper above the arrow mark inside the edge guide.
» Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Related tasks
Loading Paper or Envelopes in the Rear Paper Feed Slot

Loading Paper or Envelopes in the Rear Paper Feed Slot
You can print envelopes or documents in a variety of paper types and sizes in the rear paper feed slot.
1. Extend the output tray and open the paper stopper.

Note: If you are using legal-size or longer paper, do not open the paper stopper.
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2. Pull up the paper support for the rear paper feed slot.

4. Ifyou are inserting a stack of paper, fan the sheets first and tap the stack on a flat surface to even
the edges.

59



5. Do one of the following:
* Insert paper, printable side up and short edge first, in the center of the tray.

Caution: To prevent paper feeding problems, make sure you do not load too much paper in the
slot.

Note: You can load one sheet of binder paper with holes on one of the long edges as shown. Do
not select automatic 2-sided printing for this type of paper.

(- )

®
O

000000000000000000
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» Load up to 10 envelopes short edge first, with the flap facing down and the flap edge to the left, in
the center of the slot.

B

6. Slide the edge guides against the paper or envelope, but not too tightly.

S SE—

7. Select the size and type of paper you just loaded in the Paper Setup menu.

Always follow these paper loading guidelines:

Load only the recommended number of sheets.

Load paper short edge first, no matter which way your document faces.
Load the printable side faceup.

Load letterhead or pre-printed paper top edge first.

Do not load paper above the arrow mark inside the edge guides.
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 If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one

envelope at a time.

« If print quality declines when printing multiple envelopes, try loading one envelope at a time.

» Do not load envelopes that are curled, folded, or too thin.

» Check the paper package for any additional loading instructions.

Parent topic: Loading Paper
Related references

Paper Loading Capacity
Related tasks

Loading Paper for Documents in the Cassette

Paper Loading Capacity

Paper type Loading capacity - paper Loading capacity - rear paper
cassette feed slot
Plain paper 250 sheets 80 sheets
Copy paper Letter (8.5 x 11 inches
[216 x 279 mm]) or A4
Letterhead (8.3 x 11.7 inches
Recycled paper [210 x 297 mm])
Color paper 250 sheets 1 sheet
Preprinted paper Legal (8.5 x 14 inches
[216 x 356 mm])
Epson Bright White Paper 200 sheets 50 sheets

20 sheets for manual two-sided
printing

Epson Presentation Paper Matte

80 sheets
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Paper type

Loading capacity - paper
cassette

Loading capacity - rear paper
feed slot

Thick paper (cardstock up to 68 Ib
[256 g/m2])

10 sheets

Letter (8.5 x 11 inches
[216 x 279 mm]) or A4
(8.3 x 11.7 inches
[210 x 297 mm])

5 sheets for manual two-sided
printing

1 sheet

Legal (8.5 x 14 inches
[216 x 356 mm])

Epson Premium Presentation Paper
Matte

Epson Premium Presentation Paper
Matte Double-sided

Epson Ultra Premium Presentation
Paper Matte

Epson Brochure & Flyer Paper
Matte Double-sided

20 sheets

Envelopes

10 envelopes

Parent topic: Loading Paper

Available Epson Papers

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call

800-GO-EPSON (800-463-7766).

Paper Type

Size

Part number Sheet count

Epson Bright White Paper

Letter (8.5 x 11 inches
[216 x 279 mm])

S041586 500

63



http://www.epson.com/ink3
http://www.epson.ca

Paper Matte

[216 x 279 mm])

Paper Type Size Part number Sheet count
Epson Brochure & Flyer Paper Letter (8.5 x 11 inches S042384 150
Matte Double-sided [216 x 279 mm])
Epson Presentation Paper Matte | Letter (8.5 x 11 inches S041062 100
[216 x 279 mm])
Legal (8.5 x 14 inches S041067 100
[216 x 356 mm])
Epson Premium Presentation 8 x 10 inches (203 x 254 mm) | S041467 50
Paper Matte Letter (8.5 x 11 inches S041257 50
[216 > 279 mml]) 5042180 100
Epson Premium Presentation Letter (8.5 x 11 inches S041568 50
Paper Matte Double-sided [216 x 279 mm])
Epson Ultra Premium Presentation | Letter (8.5 x 11 inches S041341 50

Parent topic: Loading Paper

Selecting the Paper Settings for Each Source - Control Panel
You can change the default paper size and paper type for each source using the control panel on the

product.

1. Press the ¥ Paper Setup button.

2. Select the paper source you want to change and press the OK button.

You see a screen like this:

Faper Setup

BlLassette 1

Qletter/plain papers
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3. Select the paper size you loaded and press the OK button.
4. Select the paper type you loaded and press the OK button.
5. Select another paper source to change or press the 3 Back button to return to the Home screen.

Paper Type Settings - Control Panel
Paper or Media Type Settings - Printing Software

Parent topic: Loading Paper

Paper Type Settings - Control Panel

For this paper Select this Paper Type setting

Plain paper Plain Paper
Epson Bright White Paper
Epson Presentation Paper Matte

Letterhead paper Letterhead
Recycled paper Recycled
Color paper Color
Preprinted paper Preprinted
Envelopes Envelope
Epson Premium Presentation Paper Matte Prem. Matte

Epson Premium Presentation Paper Matte Double-
sided

Epson Ultra Premium Presentation Paper Matte
Epson Brochure & Flyer Paper Matte Double-sided

Thick paper (cardstock up to 68 Ib [256 g/m2]) Card Stock

Parent topic: Selecting the Paper Settings for Each Source - Control Panel
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Paper or Media Type Settings - Printing Software

For this paper Select this paper Type or Media Type setting
Plain paper Plain Paper / Bright White Paper

Epson Bright White Paper

Letterhead paper Letterhead

Recycled paper Recycled

Color paper Color

Preprinted paper Preprinted

Envelopes Envelope

Epson Presentation Paper Matte Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Epson Brochure & Flyer Paper Matte Double-sided
Epson Ultra Premium Presentation Paper Matte

Cardstock up to 68 Ib (256 g/m?) Card Stock

Note: The settings listed here are available only when printing from your computer; they do not apply to
your product's control panel settings.

Parent topic: Selecting the Paper Settings for Each Source - Control Panel

Selecting Default Paper Settings - Administrator

As an administrator, you can adjust default paper settings that apply to all print jobs sent to the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Selecting the Paper Source Settings - Administrator
Selecting Universal Print Settings

Parent topic: Loading Paper
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Selecting the Paper Source Settings - Administrator
You can change default paper source settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the up or down arrow buttons, select Menu, and press the OK button.

2. Press the down arrow button, select System Administration, and press the OK button. Enter the
administrator password, if necessary.

You see this screen:

Systen Administration
EFrinter Settings

I3 Proceed

3. Select Printer Settings and press the OK button.
Select Paper Source Settings and press the OK button.
You see a screen like this:

Faper Source Settings
ERear Paper Feed Priod
BlLast

Select the paper source options you want to use.
6. When you are finished, press the 3 Back button to return to the Home screen.
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Paper Source Settings Options
Parent topic: Selecting Default Paper Settings - Administrator
Paper Source Settings Options
Select the Paper Source Settings options you want to use for your print jobs.

Paper Source Available settings |Description
Settings option
Rear Paper Feed |Normal Select Normal to give printing priority to paper loaded in the
Priority Last rear paper feed slot.
Ad4/Letter Auto On Select On to switch the selected paper size to match the
Switching Off loaded paper (Letter or A4) if the wrong size is selected.
Auto Select Cassette 1 Select On for either of these settings to automatically print
Settings on paper from any source containing paper that matches
Rear Paper Feed your paper settings.
Error Notice Paper Size Notice | Select On for either of these settings to display an error
. message when the selected paper type or size does not
Paper Type Notice match the loaded paper.

Parent topic: Selecting the Paper Source Settings - Administrator

Selecting Universal Print Settings
You can change the default universal print settings using the product control panel.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the up or down arrow buttons, select Menu, and press the OK button.

2. Press the down arrow button, select System Administration, and press the OK button. Enter the
administrator password, if necessary.
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You see this screen:

Systen Administration
EFrinter Settings

I3 Proceed

3. Press the down arrow button, select Universal Print Settings, and press the OK button.
You see this screen:

Iniversal Print Setti...

alop Offset
2 00, Omm

4. Adjust the settings as necessary.
5. When you are finished, press the 3 Back button to return to the Home screen.
Universal Print Settings Options
Parent topic: Selecting Default Paper Settings - Administrator
Universal Print Settings Options
Select the universal print settings you want to use.

Universal Print Available Description

Settings option settings

Top Offset — Adjust the top or left margin.
Left Offset
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Universal Print Available Description
Settings option settings
Top Offsetin Back |— Adjust the top or left margin of the back page when performing
Left Offset in Back double-sided printing.
Check Paper Width |On Select On to check the paper width before printing. This
Off prevents printing beyond the edges of the paper when the
paper size settings are wrong, but may reduce the printing
speed.
Dry Time Standard Select the drying time when printing double-sided.
Long
Longer
Skip Blank Page On Select On to skip blank pages automatically.
Off
PDL Configuration |Common Selects the settings for printing with PCL and PostScript Page
Settings Description Language drivers.
PCL Menu
PS3 Menu

Parent topic: Selecting Universal Print Settings

Installing and Enabling the Optional Second Paper Cassette
Follow these instructions to add the optional paper cassette to your product.

Installing the Optional Second Paper Cassette
Enabling the Optional Paper Cassette - Windows
Enabling the Optional Paper Cassette - OS X

Parent topic: Loading Paper

Installing the Optional Second Paper Cassette
You can install the optional paper cassette to provide more paper capacity.
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1. Turn off the product and unplug the power cord and any connected cables.
Warning: To avoid electric shock, make sure you unplug the power cord.

2. Remove the paper cassette from its carton and place it where you want to set up the product.

3. Carefully lift the product as shown, then gently lower it onto the paper cassette. Make sure the
connectors and pins align correctly.

4. Reconnect the power cord and other connection cables, and plug in the product.
5. Turn on the product.
Parent topic: Installing and Enabling the Optional Second Paper Cassette

Enabling the Optional Paper Cassette - Windows

You need to enable the optional paper cassette unit before you can use it with the printer software.
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Note: If you are using the Epson Universal Print Driver or PostScript (PS3) printer software, see the
sections covering that software in this manual to enable the optional cassette unit.

1.

Do one of the following:

* Windows 10: Right-click E and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

* Windows 7: Click ﬂ and select Devices and Printers. Right-click your printer name and select
Printer properties.

* Windows Vista: Click H‘ and select Control Panel. Click Printer under Hardware and Sound,
then right-click your printer name and select Properties.

* Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Properties.

Click the Optional Settings tab.
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You see a window like this:

78 EPSOM Unncersal Print Deiver Properies =
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3. Make sure Acquire from Printer is selected, then click Get.
The optional paper sources are listed in the Current Printer Information section.
4. Click OK.
The optional paper cassette is now enabled.
Parent topic: Installing and Enabling the Optional Second Paper Cassette

Related tasks
Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Enabling the Optional Paper Cassette - PostScript Printer Software - Windows

Enabling the Optional Paper Cassette - OS X

You need to enable the optional paper cassette unit before you can use it with the printer software.
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Note: If you are using the PostScript (PS3) printer software, see the section covering that software to
enable the optional cassette unit.

1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
You see a screen like this:

General '-T:ﬁ. g | Supply Levels  Liility

To take full ocvantage of your prinbers options, confiem that they ore sccurately
shown heeo. For infeamatisn on your prinfor amd ite optisnal hardware, chock the
Erintor s documadlation.

Thick paper and envolopos: O =]

Skip Blonk Pege:  ON =)

Qg Mode: | Ot B

Parmit temporary black printing: O B

High Spesd Printing:  On =]

Warning Motificationa:  On B

Establish bigeoctional communication:  On B
Léwar Cadddtta: Cassatto 2

4. Select the optional cassette unit installed for the Lower Cassette setting.
5. Click OK.

The optional paper cassette is now enabled.

Parent topic: Installing and Enabling the Optional Second Paper Cassette

Related tasks
Enabling the Optional Paper Cassette - PostScript Printer Software - OS X
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Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows

Printing with OS X

Printing with the Epson Universal Print Driver - Windows
Printing with the PostScript (PS3) Printer Software - Windows
Printing with the PostScript (PS3) Printer Software - OS X
Cancelling Printing Using a Product Button

Printing with Windows

You can print with your product using any Windows application, as described in these sections.
Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows

Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows

Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows

Selecting Default Print Settings - Windows

Changing Automatic Update Options

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
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2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.
Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

# Printing Preference =
Wan Mo Opbonz Mardsrancs

Frmting Presets Faper Source ot Selech
Agd Riemove Presets. .. Dooument Sipe Letter (8 /2 € L1 in)

=) Cooment - Fast
=| Documenit - Standard Qualiy

Crwntatio W Pt () Lanciacape
= Document - High Quakity
Cocument - 1-Gated Paper Type Pian Paper | Engnt Whis Faper w
A1%| Documenit - 2-Up
Document - 2-Sded with 2-4p Chaslity Standard “
2hded Frining  OF w
— @ Muli-Page e w
. | Copes L = Elcotate
— a‘.| a | REverse Crder
Ay ._rjll
et Mode off
Show Settings [l Print Preview
Job Amra Lite
Reset Defaults Ik Lseeds L el

4. Forthe Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.

76



6. Select the orientation of your document.
Note: If you are printing an envelope, select Landscape.
7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select the Quality setting that matches the print quality you want to use.

9. To print on both sides of the paper, select the 2-Sided Printing setting and select the options you
want.

10. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

11. To print multiple copies and arrange their print order, select the Copies options.
12. To preview your job before printing, select Print Preview.

13. To save your print job as a project that can be modified and combined with other print jobs, select
Job Arranger Lite.

14. To reduce noise during printing when you select Plain Paper/Bright White Paper, select On in the
Quiet Mode menu.

Paper Source Options - Windows

Print Quality Options - Windows
Multi-Page Printing Options - Windows
Parent topic: Printing with Windows
Related references

Paper Type Settings - Control Panel

Related tasks

Selecting Double-sided Printing Settings - Windows
Printing Your Document or Photo - Windows

Selecting Additional Layout and Print Options - Windows

Paper Source Options - Windows

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.
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Auto Select
Automatically selects the paper source based on the selected paper size.

Paper Cassette 1
Selects the paper in cassette 1 as the paper source.

Paper Cassette 2
Selects the paper in cassette 2 as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.
Parent topic: Selecting Basic Print Settings - Windows
Print Quality Options - Windows
You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.
Draft
For draft printing on plain paper.
Standard
For everyday text and image printing.
High
For photos and graphics with high print quality.
Parent topic: Selecting Basic Print Settings - Windows
Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.

2-Up and 4-Up

Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2x1 Poster, 2x2 Poster, 3x3 Poster, 4x4 Poster

Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows

You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.
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Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

2-Sided Printing | Off W

1. Select one of the following options for 2-Sided Printing:

+ Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper
on the long edge.

» Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper
on the short edge.

2. Click the Settings button.
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You see this window:

2-5ided Printing Settings

{eft Top Right
@ir.F!!H'EdH'-‘-;: O Shaort-edge I::}L|::|r1g|—em:lg|e

Binding Margin

Front Page 0.00 5 [0.00... 1.18]

Back Page 0.00 -2 [0.00...1.18)

Uit Cimm ® inch

Start Page
(®) From Front

(") From Back

Create Folded Booklet
[[] Bookdet

Center Binding Side Binding
AL |FF__
B =

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
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5. Click the Print Density button.
You see this window:

Print Density Adjustment

Select Dacument Type

() Text (@) Text & Graphicst () Text & Photos () User-Defined
Adjustments
Print Diensity I (%)
-50 0
Increase Ink Drying Time " il (sec)
0 60

6. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

7. If necessary, select the Adjustments options you want to use.

8. Click OK to return to the Main tab.

9. Print a test copy of your double-sided document to test the selected settings.
10. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows
Print Density Adjustments - Windows

Parent topic: Printing with Windows
Double-sided Printing Options - Windows

You can select any of the available options on the 2-Sided Printing Settings window to set up your
double-sided print job.

Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.
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Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.

Print Density
Sets the level of ink coverage for double-sided printing.

Increase Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows

You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.
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To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:

» Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your
document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

+ Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. To add the following features, click the Watermark Features button:

» Anti-Copy Pattern: adds a watermark that only appears when your printout is copied
+ Watermark: adds a visible watermark to your printout

83



Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

* Header/Footer: adds information such as the date and time to the top or bottom of your printout
Note: Click the Settings button to customize the text and location of the header or footer.

3. To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

4. Select any of the Additional Settings options to customize your print.

Image Options and Additional Settings - Windows
Header/Footer Settings - Windows

Parent topic: Printing with Windows

Related tasks
Selecting Double-sided Printing Settings - Windows
Printing Your Document or Photo - Windows

Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.
Image Options

Emphasize Text
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
Additional Settings Options

Rotate 180°
Prints the image rotated 180° from its original orientation.
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High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.

Note: These settings are not saved with your document.

Header/Footer Settings

Top Left Top Center Top Right

Uger MName w Mons ' Date,Time o
Bottom Left Bottom Cenber Bottom Right

None b MHone il Mone bl

Resst Defaults IE Cancel Help

You can select to print the following information:
* User Name

» Computer Name

* Date

+ Date/Time

* Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows
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Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
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You see the available Printing Presets on the left:

E.-E_;I Printing Preferences
Main  More Options  Maintenance

Printing Presets

Add/Remove Presets...

E] Document - Fast

E] Document - Standard Quality
E Document - High Quality

=to Document - 2-Sided
Document - 2-p

cro Document - 2-Sided with 2-Up

Show Settings

Reset Defaults E Ink Levels i

2. Place your cursor over one of the Printing Presets to view its list of settings.

3. Click on a preset to change its settings, or use any of the available options on the screen to control
your printing presets.
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4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
3. Click the Maintenance tab.
You see the maintenance options:

i Frinting Preference b

Man  Mom COptions  Marderance

%l Hnzde Chedk [ﬂ- EFS0N Status Monitor 3

}; Head Cesning gl-'n-bcn'qﬁe-':rm

P\ Print Head Abgrarent

@1! Extenced Sattings
I"?; Print Queue

@ Job Brranger Lite

Language Enghsh (Engksh) “ E“_oﬁ'u'a\e Update

Werson I.43.00

0K Concel [Husip

4. Click the Extended Settings button.
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You see this window:

= = | Separniar Fuge
ack: Top ¥ L. L,
L T - -
thvars Spoal BAW Dubatyen
Sac LeF ] D W el Fage Aedorg Mode
[y -
- - Trerrt na ikma
i Bl Pagm

Frar: Cwnty Changes § Rl A ok o
Erfre LTeeTEng PATIMT

bk LS T DV e Paper S SETg

Duriput & page docume's Facadown in 2-Sied made

et Celals o Lanoed e

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.

7. Click OK to close the printer software window.

Parent topic: Printing with Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

X

= Prant

General  Ciptions

Select Printer

T8 EPSON = Microsoft XPS Docummen
= Fax

= Microseft Print ta PDF

L4 »>

Status Ready im tofie | Preferences §

Locatean:

Commeart Firid Printer...

Page Range
A Mumber of gopies: | 1 =

() Pages: 1 Collate
213

Enter either a single page numbser or a engla 1
page rangs. For example, 512

2. Click OK or Print to start printing.
Parent topic: Printing with Windows

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can

select new default print settings.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.

2. Select Printer Settings.
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You see the printer settings window:

# Printing Preference =
Wan Mo Opbonz Mardsrancs

Frating Presets Faper Souros Marin Selech

Agd Riemove Presets. .. Dooament Sre Letter (8 1/2% L1in)

W

Cocument - Fast
=| Documenit - Standard Qualiy

Crmntation () Portrait () Landacape
= DCocumenit - High Quakiy
Document - 1-5udad Pagi Ty Plain Paper [ Bright Vihié= Paper wr
A% Dooument - 2-Lp .
Document - 2-Sded with 2-4p Chaslity Standard “

ZGded Pringng | OFF

@ . - v
Copies 1 . ] collate

| REverse Crder

e o '.| ._15|
Cupet Mode off
Show Settings [ClPrint Preview
Job Amra Lite
Reset Defaults Ik Lseeds = il

ok ] coxs | vew

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows
Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
You see the printer settings window.
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3. Click the Maintenance tab.

You see the maintenance options:

W Printing Preférence =

Man Mo Options  Marderancs

%2 Hozde Ched: Ig ESS0N Status Moritor

\':‘i- Head Oeaning anﬁbcn-;F-e::rm

_hlA Prind Hisall Aligrarasnt

@11 Extindad Sattings
I'?;-Ir' Prirt Queue

EIJ Job Arranger Lite

Language Engksh (Englsh) = Q%aﬂ: Update

Werson 1.43.00

(o] Coarcel [Hislp

4. Select the language you want to use as the Language setting.

5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows

Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Software Update Settings.
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You see this window:

Software Update Settings X

Check for Software Updates on the Internet

(@) Check every 2 wesks -

ll;l Mever

cancel

3. Do one of the following:
+ To change how often the software checks for updates, select a setting in the Check every menu.
» To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows

Related tasks
Checking for Software Updates

Printing with OS X

You can print with your product using any OS X printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - OS X
Selecting Page Setup Settings - OS X
Selecting Print Layout Options - OS X
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Selecting Double-sided Printing Settings - OS X
Managing Color - OS X

Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X

Parent topic: Printing from a Computer

Selecting Basic Print Settings - OS X

Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

Printer: EPSON

L

L]

Prasaets: Default Settings

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Printar: EPSON

£

Presets: Default Settings v

Copies: 1

Pages: = All
From: 1 to: 1

B.50 by 11.00 inches

€

Paper Size: US Letter

Orientation: | 1 ¥ Toe

Preview b
+ | Auto Rotate
Scale:
® | Scale to Fit: ® | Print Entire Image
Fill Entire Paper
Copies per page: 1 <

Cance Print

Note: The print window may look different, depending on the version of OS X and the application
you are using.

Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings from the pop-up menu.

Preview

Layout

Color Matching
Paper Handling
Cover Page

¥ Print Settings

Two-sided Printing Settings

Supply Levels

You see these settings:

L8

Print Settings

Paper Source:  Auto Select

£ | 4¥

Media Type: Plain Paper [ Bright White Paper

Print Quality: Marmal

¥ Advanced Settings:

Cancel Print
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9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.

Paper Source Options - OS X

Print Quality Options - OS X

Parent topic: Printing with OS X

Related references

Paper Type Settings - Control Panel

Related tasks

Selecting Page Setup Settings - OS X

Selecting Print Layout Options - OS X

Selecting Double-sided Printing Settings - OS X
Paper Source Options - OS X

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Auto Select
Automatically selects the paper source based on the selected paper size.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - OS X
Print Quality Options - OS X

You can select any of the available Print Quality options to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type setting you have chosen.
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Draft
For draft printing on plain paper.

Normal
For everyday text and image printing.

Quality
For text and graphics with increased quality and print speed.

Parent topic: Selecting Basic Print Settings - OS X

Selecting Page Setup Settings - OS X

Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Paper Size: US Letter % B8.50 by 1.00 inches

Orientation: '* 'i- Scale: 100 %

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the "* icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with OS X
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Selecting Print Layout Options - OS X

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

Layout -
Pages per Sheet: | 1 v
g n,
Border: Mane v

Reverse page ocrientation

Flip horizontally

Cance Print

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
» Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.

Parent topic: Printing with OS X

Selecting Double-sided Printing Settings - OS X

You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Two-sided Printing Settings &

[ 4]

Two-sided Printing: Off
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Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the
version of OS X you are using.

Select one of the Two-sided Printing options.

2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

Two-sided Printing Settings &

L

Two-sided Printing:  Long-Edge binding

€3

Document Type: Text

¥ Adjustments:
Print Dansity
0 (3]
-50 0
Increased Ink Drying Time:
li] (sec)
4] +50

When printing a photo or document containing a lot of solid image
areas, reduce the density of the ink and increase its drying time.

Cancel Print

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options and Adjustments - OS X

Parent topic: Printing with OS X
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Double-sided Printing Options and Adjustments - OS X
You can select any of the available options in the Two-sided Printing Settings or Output Settings
pop-up menu to set up your double-sided print job.
Two-sided Printing Options

Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.

Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.
Adjustments

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - OS X

Managing Color - OS X

You can adjust the Color Matching settings to fine-tune the colors in your printout, or turn off color
management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.

Color Matching w
ColorSync D EPSON Color Controls
cancel | (T

2. Select one of the available options.
Color Matching Options - OS X
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Parent topic: Printing with OS X
Color Matching Options - OS X
You can select from these settings on the Color Matching menu.

ColorSync
Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.

EPSON Color Controls
Lets you manage color using controls in your printer software or turn off color management.

Parent topic: Managing Color - OS X

Selecting Printing Preferences - OS X
You can select printing preferences that apply to all the print jobs you send to your product.
1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.

102



You see a screen like this:

General Options  Supply Levels  Litility

To take full adwardage of ywour printers aptions, confirm that they are accurately shown

nere. For information on your printer and fts optional hardware, cheok the printer's
documentation.

Thick paper and enveloapes:  CAf

Skip Blank Page: | O

Quint Mode: 04

High Spead Printing:  Or

Warning Notifications: Or

Estanksh bidirectional communication:  Or

AR IR IR IR AN A E)

Lowar Cosbeite: Mg

Cance oK

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - OS X
Parent topic: Printing with OS X
Printing Preferences - OS X
You can select from these settings on the Options or Driver tab.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Quiet Mode
Lessens noise during printing but may decrease print speed.

High Speed Printing
Speeds up printing but may reduce print quality.
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Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Lower Cassette
Specifies whether the optional cassette is present.

Parent topic: Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Print Settings -

Paper Source: Auto Select

Media Type: Plain Paper [ Bright White Paper

[+ 2NE+ 30N+

Print Quality: MNorma

Advanced Settings:

Cancel Print

Checking Print Status - OS X
Parent topic: Printing with OS X
Checking Print Status - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
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You see the print status window:

[ BN & EPSOM

W L¥
Paust Seltings
1836131_127T0960758910_6552316_n.jpg

a

2. Select the following options as necessary for your version of OS X:
» To cancel printing, click the print job and click I:I or Delete.

* To pause a print job, click the print job and click I:' or Hold. To resume a print job, click the
paused print job and click |:| or Resume.
» To pause printing for all queued print jobs, click Pause or Pause Printer.
» To display other printer information, click Settings or Supply Levels.
Parent topic: Printing Your Document or Photo - OS X

Printing with the Epson Universal Print Driver - Windows

You can print with the Epson Universal Print Driver using any Windows printing program, as described in
these sections.

Synchronizing Printer Settings - Epson Universal Print Driver - Windows

Selecting Basic Print Settings - Epson Universal Print Driver - Windows

Selecting Additional Layout and Print Options - Epson Universal Print Driver - Windows

Selecting Maintenance Options - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows

Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows

Parent topic: Printing from a Computer
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Synchronizing Printer Settings - Epson Universal Print Driver - Windows

You may need to synchronize the printer driver with the product if the printer driver does not detect the
correct information or settings from the product.

Note: You must sync the printer driver before you can use any optional equipment installed on the
product, such as an optional cassette unit.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

+ Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

* Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

2. Click the Optional Settings tab.
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You see this window:

78 EPSOM Unncersal Print Deiver Properies =
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3. Make sure Acquire from Printer is selected and click Get.

Note: Select the Only Optional Information checkbox if you only want to enable optional
equipment, such as an optional cassette unit.

The product's settings and other information appears in the Current Printer Information area.
4. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows

Related tasks
Enabling the Optional Paper Cassette - Windows
Enabling the Optional Paper Cassette - PostScript Printer Software - Windows
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Selecting Basic Print Settings - Epson Universal Print Driver - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select EPSON Universal Print Driver as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

Prelmg Brearts aper e Lot et
e M Eomts ooument Sipe Lt {8 U3
v v o s v A
el wa L aper Type Far Fape | Brgr e Faoer
Jhalty St d

2Gded Frining | OFF

MUt Page off

s LETFGHE

Reset Dt
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Note: For more information about a setting, right-click it and select Help.

4. Forthe Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.
6. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.
7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select the Quality setting that matches the print quality you want to use.
9. To print on both sides of the paper, select one of the 2-Sided Printing settings.

10. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

11. To print multiple copies and arrange their print order, select the Copies options.
12. To preview your job before printing, select Print Preview.

13. To save your print job as a project that can be modified and combined with other print jobs, select
Job Arranger Lite.

Parent topic: Printing with the Epson Universal Print Driver - Windows
Related references

Paper or Media Type Settings - Printing Software

Paper Source Options - Windows

Print Quality Options - Windows

Multi-Page Printing Options - Windows
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Selecting Additional Layout and Print Options - Epson Universal Print Driver -

Windows

You can select a variety of additional layout and printing options for your document or photo on the More

Options tab.

Emage Options. ..

‘Watermark Festres

orfderial Job

Aibchlional Sethrgs

|Ratats 180

Shive SSRGS

Reget Detuits

Lo 3 T =g

Note: For more information about a setting, right-click it and select Help.

To change the size of your printed document or photo, select the Reduce/Enlarge Document

checkbox and select one of these sizing options:

+ Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of the
your document or photo as the Document Size setting, and the size of your paper as the Output

Paper setting. If you want to center your image on the paper, select the Center option.

+ Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage
Select the percentage in the % menu.

1.
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2. Select Image Options to access additional settings for improving printed images.
3. To add the following features, click the Watermark Features button:
+ Watermark: adds a visible watermark to your printout.

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

* Header/Footer: adds information such as the date and time to the top or bottom of your printout.
Note: Click the Settings button to customize the text and location of the header or footer.

4. To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.
Parent topic: Printing with the Epson Universal Print Driver - Windows

Related references
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
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Selecting Maintenance Options - Epson Universal Print Driver - Windows
You can select maintenance and other optional settings on the Maintenance tab.

i EPSOH Uriversal Prink Duiver Printing Prefenences =
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Note: For more information about a setting, right-click it and select Help.

* Nozzle Check lets you print a nozzle check pattern to check for clogged nozzles.
* Head Cleaning lets you clean the print head.
» Network printer search lets you search for and connect to a product on the network.

* Job Arranger Lite lets you save your print job as a project that can be modified and combined with
other print jobs.

+ Extended Settings lets you change a variety of print settings.
» Print Queue displays all the print jobs in queue. You can also cancel or restart print jobs.
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* Printer and Option Information displays information on the printer settings and any optional
equipment installed.

* Language lets you change the language of the printer software screens.
Extended Settings - Epson Universal Print Driver - Windows

Parent topic: Printing with the Epson Universal Print Driver - Windows
Related concepts

Print Head Nozzle Check

Print Head Cleaning

Extended Settings - Epson Universal Print Driver - Windows

You can select from these settings on the Extended Settings window.
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Printer Control Language
Lets you select the printer control language.

Graphics Mode

Lets you select the mode by which to output PDL commands to the product.
TrueType Font

Lets you select how you want to print TrueType fonts.
Offset Settings

Lets you make fine-tune adjustments to the print position of data on your printout.
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Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Print as Bitmap

Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Refine screening pattern
Prints graphics with a finer screening pattern.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Uses the collate settings specified in the application
Prints using the collate setting in your application.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Collate Using Printer Driver
Prints and collates multi-page documents using the printer driver. Deselect this checkbox to use the
product to collate your print jobs instead. (This setting is automatically enabled if there is not enough
memory on the product to collate your print job.)

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Parent topic: Selecting Maintenance Options - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Print Preferences.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Print Preferences.
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* Windows 7: Click EI' and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printing Preferences.

* Windows Vista: Click H and select Control Panel. Click Printer under Hardware and Sound,
right-click EPSON Universal Print Driver, and select Printing Preferences.

* Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Printing Preferences.

You see the printer settings window:
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wrae Order
n
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Shars SETONgE
Reset Defaits
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Note: For more information about a setting, right-click it and select Help.

Select the print settings you want to use as defaults in all your Windows programs.
Click OK.
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These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Parent topic: Printing with the Epson Universal Print Driver - Windows

Locking Printer Settings - Epson Universal Print Driver - Windows
Administrators can lock some printer settings to prevent unauthorized changes.
1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Printer properties.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click © and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

* Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

. Click the Optional Settings tab.
3. Click Driver Settings.
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You see this window:

EL

[ M Page

[ il Dooument Setongs

Aeset Defaits o Carcel Help

4. Select the checkbox for the settings you want to lock. To lock all print settings, select All Document
Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.
Epson Universal Print Driver Locked Setting Options
Parent topic: Printing with the Epson Universal Print Driver - Windows
Epson Universal Print Driver Locked Setting Options
Select the options you want to use for any locked print settings.
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Setting Options Description
Watermark Various text Lets you select the text for the watermark or prohibit
watermarks watermarks
Add/Delete Lets you add or delete a customized text or image-based
Settings watermark
Lets you select the size, position, color and other watermark
settings
Header/Footer Off Prohibits headers or footers
On Allows headers and footers
Settings Lets you select the text and position for printing headers and
footers
2-sided printing | Off Allows printing on only one side of the paper
On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings
2-Up Allows printing of 2 pages on one sheet of paper
4-Up Allows printing of 4 pages on one sheet of paper

Parent topic: Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows

You can use the Epson Universal Print Driver to find and add network printers.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

+ Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.
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* Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

Click the Optional Settings tab.
You see this window:
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Click Network printer search.
When you see the search results, select Add found printers.
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You see a screen like this:
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5. Select the printer or printers you want to add.
6. Click Add to Printer Folder.
The selected printer or printers appear in the lower section of the screen.
7. Select the checkbox next to the product you want to make your default printer, if necessary.
8. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows
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Printing with the PostScript (PS3) Printer Software - Windows

You can print with the PostScript (PS3) printer software using any Windows printing program, as
described in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, go to epson.com/support/wfm5194downloads.

Enabling the Optional Paper Cassette - PostScript Printer Software - Windows
Selecting Basic Print Settings - PostScript Printer Software - Windows

Selecting Additional Layout and Print Options - PostScript Printer Software - Windows
Selecting Default Print Settings - PostScript Printer Software - Windows

Parent topic: Printing from a Computer

Enabling the Optional Paper Cassette - PostScript Printer Software - Windows

If you installed the optional paper cassette unit, you need to enable it before you can use it with the PS3
printer software.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click your product name and select
Printer Properties.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product name, and select Properties.

+ Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Properties.

2. Click the Device Settings tab.
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You see a window like this:

fra EPSOM WF-308  PS3 Seres Prchprrhr'h b

Generdl  Shaing  Pors  Advanced  Color Management  Security  Dewice Settings
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Awailable PostScript Memorny: |JERh T
Output Protecel: ASCH
Send CTRL-D Before Each Job: Mo
Send CTRL-D After Each Job: Yes
Convert Gray Text to PostScript Gray: Mo
Canwvert Gray Graphics ta PastSeript Gray: Ne
Add Eure Currency Symbol te PostScript Fonts: No
Job Timeout: 0 seconds
Wait Timeout: [ seconds
Minimum Font Soe to Download as Outhine: 100 peoel(s)
Maximum Font Size te Download as Bitmap: 500 pivel(s)
= m Installable Options
Lower Cassette Unit: Mone
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3. Select the optional cassette installed as the Lower Cassette Unit setting.
4. Click OK.

The optional paper cassette is now enabled.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Related tasks
Enabling the Optional Paper Cassette - Windows
Synchronizing Printer Settings - Epson Universal Print Driver - Windows
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Selecting Basic Print Settings - PostScript Printer Software - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use, and then click the
Preferences button.

You see the Layout tab of your printer settings window:

= Printing Praferences .
eyl  FaperCualty
Dnentatwon:
[ Porrat |
Prnt on Both Sedes
= Mane
Page Orden [
Front to Back =
Page Format —_—
®) Pages per Sheet 1 . =

i) Bocklet

Adysnced...

4. Select the orientation of your document.
5. To print on both sides of the paper, select one of the Print on Both Sides settings.
6. To change the printing order of the pages, select one of the Page Order settings.
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7. To print multiple pages on one sheet of paper, adjust the Pages per Sheet setting.
8. To create a folded booklet out of your photo or document, select the Booklet option.
9. Click the Paper/Quality tab.

You see this window:

= Printing Praferences o
Leyout  Faper Tualty

Tray Selection

edia: Plain.

Adyanced...

G

10. Select the Paper Source that matches where you loaded the paper you want to print on.
11. Select Plain as the Media setting.

Note: The PostScript printer software supports plain paper printing on these paper and envelope
sizes:

* A4 (8.3 x 11.7 inches [210 x 297 mm])
+ Letter (8.5 x 11 inches [216 x 279 mm])
* No. 10 (4.1 x 9.5inches [105 x 241 mm])

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows
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Selecting Additional Layout and Print Options - PostScript Printer Software - Windows

You can select a variety of additional layout and printing options for your document or photo by clicking
the Advanced button.

EPS0MN P53 Senes Advanced Opbions >

= EFS0M P53 Series Advanced Document Settings
Paper/Qutput
Letter
= _|_|.'| G raphic
Print ﬂueli!:_.': m
Scaling: 100 %
TrueType Font: Substitute with Device Font
e Document Options
Advanced Printing Features: Enabled
Pages per Sheet Layout: Right then Down
Booklet Binding Edge: On Left Edge
-9 Posthonpt Options
=%, Printer Features
Ink Save Mode: O
Rotate by 180°: Off

o nh =~

o o

Select the size of the paper you loaded as the Paper Size setting.
Select the Print Quality option that matches the print quality you want to use.
Adjust the Scaling setting to reduce or enlarge your document or photo by a specific percentage.

Adjust the Pages Per Sheet Layout setting to change the order of multiple pages on a single sheet
of paper when you have adjusted the Pages Per Sheet setting on the Layout tab.

Adjust the Booklet Binding Edge setting to change the orientation of your printed booklet.
Expand the PostScript Options heading to access the advanced PostScript printer software features.
Select any of the remaining Printer Features options to customize your printouts.
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Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Selecting Default Print Settings - PostScript Printer Software - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Do one of the following:

Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Print Preferences.

Windows 7: Click E]' and select Devices and Printers. Right-click your product name and select
Printing Preferences.

Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Printing Preferences.

Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Printing Preferences.
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You see the printer settings window:

= Printing Praferences o
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2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Printing with the PostScript (PS3) Printer Software - OS X

You can print with the PostScript (PS3) printer software using any OS X printing program, as described
in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, go to epson.com/support/wfm5194downloads .
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Enabling the Optional Paper Cassette - PostScript Printer Software - OS X
Selecting Basic Print Settings - PostScript Printer Software - OS X
Selecting Page Setup Settings - PostScript Printer Software - OS X
Selecting Print Layout Options - PostScript Printer Software - OS X

Sizing Printed Images - PostScript Printer Software - OS X

Managing Color - PostScript Printer Software - OS X

Printing Your Document or Photo - PostScript Printer Software - OS X

Parent topic: Printing from a Computer

Enabling the Optional Paper Cassette - PostScript Printer Software - OS X

If you installed the optional paper cassette unit, you need to enable it before you can use it with the PS3
printer software.

1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
You see a screen like this:

General Options  Supply Levels

To tame full agwardage of wour printers aptions, confirm that they anre accurately shown
nere. For information on your printer and its optional hardware, cheok the printer's
documentation.

Lower Cassetie Unit: | Mone

Cance OK
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4. Select the optional cassette installed as the Lower Cassette Unit setting.
5. Click OK.

The optional paper cassette is now enabled.

Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Related tasks
Enabling the Optional Paper Cassette - OS X

Selecting Basic Print Settings - PostScript Printer Software - OS X
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

Printer: EPSON

(B

Presets: Default Settings

L]

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Printar: EPSON

£

Presets: Default Settings v

Copies: 1

Pages: = All
From: 1 to: 1

B.50 by 11.00 inches

€

Paper Size: US Letter

Orientation: | 1 ¥ Toe

Preview b
+ | Auto Rotate
Scale:
® | Scale to Fit: ® | Print Entire Image
Fill Entire Paper
Copies per page: 1 <

Cance Print

Note: The print window may look different, depending on the version of OS X and the application
you are using.

Select the Two-Sided, Copies, and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Paper Feed from the pop-up menu.

Preview

Layout
Color Matching
Paper Handling

¥ Paper Feed

Cover Page

Printer Features

You see these settings:

<

Paper Fead

* All Pages From:  Auto Select <
First Page From: Rear Paper Feed

Remaining From: Rear Paper Feed

Cancel Print

9. Select All Pages From or First Page From and select the paper source you want to print from.
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10. Select Printer Features from the pop-up menu.

Preview

Layout

Color Matching
Paper Handling
Paper Feed
Cover Page

You see these settings:

Printer Features -
Feature Sets:  Quality -
MediaType: | Plain -
Print Quality: Fine v
Cancel Print

11. Select Plain as the MediaType setting.

Note: The PostScript printer software supports plain paper printing on these paper and envelope
sizes:

* A4 (8.3 x 11.7 inches [210 x 297 mm])
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* Letter (8.5 x 11 inches [216 x 279 mm])
* No. 10 (4.1 x 9.5 inches [105 x 241 mm])

12. Select one of the following Print Quality options:

» For fast printing with reduced quality, select Fast.

» For printing text and graphics with good quality and print speed, select Fine.

» For the best printing with reduced speed, select Maximum.

13. Select any of the available print options.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Related tasks

Selecting Page Setup Settings - PostScript Printer Software - OS X
Selecting Print Layout Options - PostScript Printer Software - OS X
Printing Your Document or Photo - PostScript Printer Software - OS X

Selecting Page Setup Settings - PostScript Printer Software - OS X

Depending on your application, you may be able to select the paper size and orientation settings from

the print window.

Orientation: 1 ]

Paper Size: US Latter

Ts.

r
o

B.50 by 11.00 inches

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. You can also select a custom
setting to create a custom paper size.

2. Select the orientation of your document or photo as shown in the print window.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.
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Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Related tasks
Selecting Basic Print Settings - PostScript Printer Software - OS X

Selecting Print Layout Options - PostScript Printer Software - OS X

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

L4

Layout

£y

Pages per Sheet: 1
&
Border: MNone =

Two-Sided: Off <

Reverse page orientation
Flip horizontally

Cancel Print

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.

» To print on both sides of the page, select one of the Two-Sided settings.

» Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
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Sizing Printed Images - PostScript Printer Software - OS X

You can adjust the size of the image as you print it by selecting Paper Handling from the pop-up menu
on the Print window.

Paper Handling b

+| Collate pages

L3

Pages to Print: | All pages

Page Order: Automatic

L4

Scale to fit paper size

Cance Print

» To print only selected pages in a multi-page document, select an option from the Pages to Print pop-
up menu.

» To adjust the order in which pages are printed, select an option from the Page Order pop-up menu.

» To scale the image to fit on a specific paper size, select the Scale to fit paper size checkbox and
select a paper size from the Destination Paper Size pop-up menu.

Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Managing Color - PostScript Printer Software - OS X

You can adjust the Color Matching settings to fine-tune the colors in your printout.
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1. Select Color Matching from the pop-up menu in the print window.

Color Matching b

¢ ColorSync | | In printer

o

Profile: Automatic >

Cancel Print

2. Do one of the following:

» To print using standard color profiles for your product and paper to help match image colors,
select ColorSync. Select one of the available Profile options to change the active color profile.

» To use the product's default color matching, select In printer.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Printing Your Document or Photo - PostScript Printer Software - OS X
Once you have selected your print settings, you are ready to print.
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Click Print at the bottom of the print window.

Printer Features -
Feature Sets:  Quality +
MediaType: | Plain =
Print Quality: Fine -
Cance Print

Checking Print Status - PostScript Printer Software - OS X
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
Checking Print Status - PostScript Printer Software - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
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You see the print status window:

=i

W =

About Downloads
i

L]

2. Select the following options as necessary for your version of OS X:
* To cancel printing, click the print job and click I:l or Delete.

* To pause a print job, click the print job and click I:' or Hold. To resume a print job, click the
paused print job and click |:| or Resume.
» To pause printing for all queued print jobs, click Pause or Pause Printer.
» To display other printer information, click Settings or Supply Levels.
Parent topic: Printing Your Document or Photo - PostScript Printer Software - OS X

Cancelling Printing Using a Product Button

If you need to cancel printing, press the ® Stop button on your product.
Parent topic: Printing from a Computer
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Replacing the Ink Cartridge and Maintenance Box

The maintenance box stores ink that gets flushed from the system during print head cleaning. When the
ink cartridge is expended or the maintenance box is at the end of its service life, you need to replace it.

You may also need to replace a cartridge that is more than six months old if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges and maintenance boxes responsibly
and in accordance with local requirements. If you would like to return your used ink cartridges and
maintenance boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Status of the Ink Cartridge and Maintenance Box
Purchase Epson Ink Cartridges and Maintenance Box
Removing and Installing the Ink Cartridge

Replacing the Maintenance Box

Check Status of the Ink Cartridge and Maintenance Box

Your product and its software will let you know when the ink cartridge is low or expended, or when the
maintenance box needs to be replaced.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can check ink cartridge and maintenance box status by using the printer buttons or the utilities
included with the standard Epson printer software. To download the standard Epson printer software, go
to epson.com/support/wfm5194downloads.

Checking Cartridge Status on the LCD Screen
Checking Cartridge and Maintenance Box Status with Windows
Checking Cartridge and Maintenance Box Status with OS X

Parent topic: Replacing the Ink Cartridge and Maintenance Box

Checking Cartridge Status on the LCD Screen

When the ink cartridge is low, the orange Error light flashes. When the cartridge is expended, the
orange Error light stays on. You can use the Ink Level option to check the status of the cartridge and
maintenance box.

1. Press the up or down arrow buttons, select Menu, and press the OK button.
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2. Select Ink Level and press the OK button.
You see a screen like this:

Ink Level

=i 4,

@ oF

3. To exit, press the OK button.
Parent topic: Check Status of the Ink Cartridge and Maintenance Box

Related tasks
Removing and Installing the Ink Cartridge
Replacing the Maintenance Box

Checking Cartridge and Maintenance Box Status with Windows

A low ink reminder appears if you try to print when ink is low, and you can check your cartridge or
maintenance box status at any time using a utility on your Windows computer.

1. To check your status, access the Windows Desktop, double-click the product icon in the Windows
taskbar, and click Details.
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You see this window:

W EPsON -

EPSON "%

It i= ready toprint.

Ink Leve

Black

Information

Maintenance Bax Service Life

Print Queus { O

2. Replace or reinstall the maintenance box or ink cartridge as indicated on the screen.

Note: If the cartridge installed in the product is broken, incompatible with the product model, or
improperly installed, Epson Status Monitor will not display an accurate cartridge status.

3. Todisable the low ink reminder, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.
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You see this window:

Monitoning Preferences : EPSON >
Select Notification
Event Screen Motification 3
& Errar on
O Communication Error Off
& Printer Selection Errar on
O ink Low Off v
] simple status notification Default
Select Shortout Icon

] Register the shortout icon to the taskbar

Diouble-dicking the Shortout Ioon
opens the Printer Status Window.
] Allow monitoring of shared printers

Display Epson Offers

[]Share my usage information with Epson

5] | oo =

4. Deselect the See Low Ink Reminder alerts checkbox at the bottom of the screen.
5. To disable promotional offers, deselect the Display Epson Offers checkbox.
6. Click OK.

Parent topic: Check Status of the Ink Cartridge and Maintenance Box
Related tasks
Checking Cartridge Status on the LCD Screen
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Removing and Installing the Ink Cartridge
Replacing the Maintenance Box

Checking Cartridge and Maintenance Box Status with OS X
You can check the status of your ink cartridge and maintenance box using a utility on your Mac.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select

Open Printer Utility.
2. Select EPSON Status Monitor.
You see this window:

L ] Epson Printer Utility 4

EPSON EPSON

ﬁ EPSON Status Monitor

nk Love

Blsik
THTEL

nformation

Maintenance Bax Service Life
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3. Do the following as necessary:
* You can update the ink cartridge and maintenance box status by clicking Update.
* Replace or reinstall the maintenance box or ink cartridge as indicated on the screen.

Note: If the cartridge installed in the product is broken, incompatible with the product model, or
improperly installed, Epson Status Monitor will not display an accurate cartridge status.

Parent topic: Check Status of the Ink Cartridge and Maintenance Box

Related tasks

Checking Cartridge Status on the LCD Screen
Removing and Installing the Ink Cartridge
Replacing the Maintenance Box

Purchase Epson Ink Cartridges and Maintenance Box

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com/ink3 (U.S. sales) or
epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find
the nearest one, call 800-GO-EPSON (800-463-7766).

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.

The cartridge included with the printer is designed for printer setup and not for resale. After some ink is
used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Ink Cartridge and Maintenance Box Part Numbers
Parent topic: Replacing the Ink Cartridge and Maintenance Box

Ink Cartridge and Maintenance Box Part Numbers
Use these part numbers when you order or purchase a new ink cartridge or maintenance box.
Maintenance box part number: T6710
Ink cartridge: Black 792XL High-capacity

Note: For best printing results, use up a cartridge within 6 months of opening the package.
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Parent topic: Purchase Epson Ink Cartridges and Maintenance Box

Removing and Installing the Ink Cartridge
Make sure you have your replacement cartridge handy before you begin. You must install the new
cartridge immediately after removing the old one.

Caution: Leave your old cartridge in the printer until you are ready to replace it to prevent the print head
nozzles from drying out. Do not open the ink cartridge package until you are ready to install the ink. The
cartridge is vacuum packed to maintain reliability.

Turn on your product.

2. Ifthe ink cartridge is low or expended, a message appears on your product and on your computer
screen.

3. Open the front cover.

—

)
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4. Push the ink cartridge in, then release it and pull it out of the slot.

= N
\

Note: Dispose of the used cartridge carefully. Do not take the used cartridge apart or try to refill it.
Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,

flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.
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5. Remove the cartridge from the package.

\

S
D 1"!'

Caution: Do not touch the green chip on the cartridge. Install the new cartridge immediately after
removing the old one; if you do not, the print head may dry out and be unable to print.

6. Gently shake the ink cartridge horizontally for about five seconds as shown.

(;/‘)

[

Caution: Do not remove any labels or seals, or ink will leak.
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7. Insert the new cartridge into the holder and push it in until it clicks into place.

8. When you are finished, close the front cover.

—

S

The product starts charging the ink and returns to its previous state when finished.

Note: Do not turn off the printer during ink replacement. If you see a cartridge check message on the
LCD screen, press the OK button to check if it installed correctly.

Caution: If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and
store it in the same environment as the printer. The valve in the ink supply port is designed to contain
any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with
the label facing up; do not store cartridges upside-down.

Parent topic: Replacing the Ink Cartridge and Maintenance Box
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Replacing the Maintenance Box
Make sure you have a new maintenance box before you begin.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for more than a
week. Keep the maintenance box away from direct sunlight.

Make sure the product is not printing.
2. Remove the new maintenance box from its package.

Caution: Do not touch the green chip on the maintenance box.

3. Press the buttons on the sides of the rear cover and remove it.
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4.

6.

Grasp the maintenance box as shown and pull it out of its holder.

Note: Do not tilt the used maintenance box or take it apart.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep the maintenance box out of the reach of children and do not drink the ink.

Place the used maintenance box in the plastic bag that came with the new maintenance box. Seal
the bag and dispose of it carefully.

Insert the new maintenance box into the holder and push it all the way in.
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7. Press the buttons on the sides of the rear cover and reattach it.

Parent topic: Replacing the Ink Cartridge and Maintenance Box
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Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.

Note: When using the PCL or PostScript (PS3) printer software with the product, you can clean and
align the print head and run a nozzle check by using the printer buttons or the utilities included with the
standard Epson printer software. To download the standard Epson printer software, go to
epson.com/support/wfm5194downloads.

If running these utilities does not solve the problem, you may need to replace the ink cartridge.

Print Head Maintenance
Print Head Alignment
Cleaning the Paper Guide

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if the ink cartridge is expended, and may not be able to clean it
when the cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning

Parent topic: Adjusting Print Quality

Related topics
Replacing the Ink Cartridge and Maintenance Box

Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance
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Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Make sure plain paper is loaded in Cassette 1.
2. Press the up or down arrow buttons, select Menu, and press the OK button.
3. Press the down arrow button, select Maintenance, and press the OK button.
You see this screen:

Maintenance
BPrint Head Nozzle Che

4. Select Print Head Nozzle Check.
You see a screen like this:

Frint Head Mozzle C...
Frint a nozzle check p

&8 Yes & Mo

5. Press the up arrow button.
The nozzle pattern prints.

153



Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Do one of the following:
+ If there are no gaps, press the down arrow button, select Finish, and press the OK button.
* If there are gaps or the pattern is faint, select Clean the print head and press the OK button.
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8. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the
process as necessary.

If you don’t see any improvement after cleaning the print head up to 4 times, leave the product turned on
and wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, the ink
cartridge may be old or damaged and needs to be replaced.

Parent topic: Print Head Nozzle Check

Related tasks
Cleaning the Print Head Using the Product Control Panel
Removing and Installing the Ink Cartridge

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

» OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Nozzle Check.
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You see a window like this:

Eal MNozzle Check

To parform & nozde chack, make sure that the printer is on and
connected to the computer, Also make sure that A4 or Letter size plain
paper is loaded in the rear paper feed or the paper cassette. Click
[Print] to print & noezle chedk pattern or dick [Cancel] to quit,

5. Click Print.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

7. |Ifthere are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.
Parent topic: Print Head Nozzle Check
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Related tasks
Cleaning the Print Head Using a Computer Utility

Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if the ink cartridge is expended, and may not be able to clean it
when the cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility

Parent topic: Print Head Maintenance

Related tasks
Removing and Installing the Ink Cartridge

Cleaning the Print Head Using the Product Control Panel
You can clean the print head using the control panel on your product.
1. Make sure plain paper is loaded in Cassette 1.
2. Press the up or down arrow buttons, select Menu, and press the OK button.
3. Press the down arrow button, select Maintenance, and press the OK button.
4. Press the down arrow button, select Print Head Cleaning, and press the OK button.
You see this screen:

Print Head Cleaning
Clean the print head?

&8 Yes & Mo

5. Press the up arrow button.
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When the cleaning cycle is finished, you see a message on the screen.
Caution: Never turn off the product during a cleaning cycle or you may damage it.

Select Print Nozzle Check Pattern and press the OK button.
Press the up arrow button.

Press the down arrow button, select Finish, and press the OK button to confirm that the print head is
clean.

If you don’t see any improvement after cleaning the print head up to 4 times, leave the product turned on
and wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, the ink
cartridge may be old or damaged and needs to be replaced.

Parent topic: Print Head Cleaning

Related tasks

Removing and Installing the Ink Cartridge

Cleaning the Print Head Using a Computer Utility
Checking the Nozzles Using the Product Control Panel

Cleaning the Print Head Using a Computer Utility

You can clean the print head using a utility on your Windows or Mac computer.

1.
2.
3.

Make sure there are no errors on the LCD screen.

Load a few sheets of plain paper in the product.

Do one of the following:

* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

» OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

Select Head Cleaning.
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You see a window like this:

# Head Cleaning b4

\Q- Click [Start] to dean the print hesd nozdes. Because deaning
consumes some ink, only cean the print head when faint ansas or
gaps appear in your primtout, Use the MNozzle Chedk” utiity first to
confirm that the print head nesds to be deaned. IF the ink & low or
expended, replace the cartridge first,

o

5. Click Start to begin the cleaning cycle.
Note: Do not open the front cover during the cleaning cycle.
Caution: Never turn off the product during a cleaning cycle or you may damage it.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.
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7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

+ If there are no gaps, click Finish.
« If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 4 times, leave the product turned on
and wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, the ink
cartridge may be old or damaged and needs to be replaced.
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Parent topic: Print Head Cleaning

Related tasks
Removing and Installing the Ink Cartridge

Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Aligning the Print Head Using a Computer Utility

Parent topic: Adjusting Print Quality
Aligning the Print Head Using the Product Control Panel

You can align the print head using the touch panel on your product.

1. Make sure plain paper is loaded in Cassette 1.

2. Press the up or down arrow buttons, select Menu, and press the OK button.

3. Press the down arrow button, select Maintenance, and press the OK button.

4. Press the down arrow button, select Print Head Alignment, and press the OK button.

You see this screen:

Print Head Alignment
gRuled Line Alighment

(I3 Proceed

5. Do one of the following:
+ Iftext and lines are misaligned, select Ruled Line Alignment, and press the OK button.
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8.

+ If your printouts look blurry or vertical lines are misaligned, select Vertical Alignment, and press
the OK button.

+ If you see horizontal bands at regular intervals, press the down arrow button, select Horizontal
Alignment, and press the OK button.

Press the up arrow button to print an alignment sheet.
Note: Do not cancel printing while you are printing head alignment patterns.

After the alignment sheet is printed, you see a series of screens asking you to select the best square
in each pattern set.

Check the printed patterns, then choose the number representing the best square for each set and
press the OK button.

After you have selected the number for all the sets, press the OK button.

Parent topic: Print Head Alignment

Aligning the Print Head Using a Computer Utility

You can align the print head using a utility on your Windows or Mac computer.

1.
2.

Load a few sheets of plain paper in the product.
Do one of the following:
* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

* OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

Select Print Head Alignment.
Click Next, then click Print to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.
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You see a window like this:

el Print Head Alignment X

Look at the algnment sheet.

hpA Find the sguare without any visble bands in sefs = 1. S=lect the number
that corresponds to that square from the list below for all sets. Then dide
[Mext =],
If every square contains a band, select the square with the thinnest
band or bands. Then dick [Realignment].

Realignment Cancel Mext =

5. Check the printed pattern and follow the instructions on the screen to choose the number of the best
printed pattern for each set.

 After choosing a pattern number, click Next.

+ If no patterns are aligned in one or more of the sets, choose the closest one in each set and click
Realignment. Then print another alignment sheet and check it.

Note: Click Skip (where available) if you want to skip a particular alignment sheet.

6. When you are done, click Finish.
Parent topic: Print Head Alignment
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Cleaning the Paper Guide
If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink.
1. Load a few sheets of plain paper in the product.
2. Press the up or down arrow buttons, select Menu, and press the OK button.
3. Press the down arrow button, select Maintenance, and press the OK button.
You see this screen:

Maintenance
BPrint Head Nozzle Che

Press the down arrow button, select Paper Guide Cleaning, and press the OK button.
Select the cassette or rear paper feed and press the OK button.

Press the up arrow button.

Check the back of the ejected paper to see ifitis clean.

® N o o bk

Repeat as necessary until the paper comes out clean.
Parent topic: Adjusting Print Quality
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Cleaning and Transporting the Product

If your product gets dirty or you need to move it some distance, follow the instructions in these sections.

Cleaning the Product
Transporting Your Product

Cleaning the Product

To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, benzene, alcohol, or paint thinner to clean the product or you may
damage it. Do not place anything on top of the cover or use the cover as a writing surface, or it could get
permanently scratched. Do not use oil or other lubricants inside the product or let water get inside.

Turn off the product.

Unplug the power cable.

Disconnect any connected cables.

Remove all the paper from the product.

Clean the paper cassette or cassettes using a soft brush.

S O

Clean the outer case with a soft cloth dampened with a mild detergent.
Note: Close the rear paper feed slot and output tray when you are not using the product.

Parent topic: Cleaning and Transporting the Product

Transporting Your Product

If you need to store your product or transport it a long distance, prepare it for transportation as described
here.

Caution: During transportation and storage, follow these guidelines:
» Avoid tilting the product, placing it vertically, or turning it upside down; otherwise, ink may leak.

* Leave the ink cartridge installed. Removing the cartridge can dry out the print head and may prevent
the product from printing.
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Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

Turn off the product.

Unplug the power cable.

Disconnect any connected cables.

Remove all the paper from the product.

Close the rear paper feeder and the output tray.

o g bk wbd -~

Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product. Make sure the box adequately protects the product control panel.

Keep the product level during transportation. If print quality has declined when you print again, clean and
align the print head.

Parent topic: Cleaning and Transporting the Product

Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates

Product Status Messages

Running a Product Check

Resetting Control Panel Defaults

Solving Setup Problems

Solving Network Problems

Solving Paper Problems

Solving PCL/PostScript Problems

Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems

Uninstall Your Product Software

Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software.
Visit the driver download site at (U.S. downloads or Canadian downloads).

* Windows: Your printer software automatically checks for updates. You can also manually update the
software by selecting Software Update here:

» Accessing the Windows Desktop and right-clicking the product icon in the Windows taskbar
* On the Maintenance tab in the printer settings window

You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

» 0OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

Parent topic: Solving Problems
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Product Status Messages

You can often diagnose problems with your product by checking the messages on its LCD screen.

Note: If the screen is dark, press a button to wake the product from sleep mode.

LCD screen message

Condition/solution

Paper Jam

If paper is jammed in the product, follow the instructions in this
guide to remove the jammed paper from the indicated area.

Printer Error

A serious error has occurred. Turn the product off and then back
on again. If the error continues, check for a paper jam. If there is
no paper jam, contact Epson for support.

You need to replace the ink
cartridge.

Replace the ink cartridge.

Memory full.

The size of the print job is too large. Lower the print quality or
resolution, change the format setting, or reduce the number of
images or fonts in the print job.

Invalid IP address and subnet mask.

There is a problem with the network connection to your product.

Recovery mode

An error has occurred during firmware updating. Connect your
product using a USB cable and try downloading the Firmware
Update from Epson's support website. If you still need help,
contact Epson for support.

Parent topic: Solving Problems
Related references

Paper Jam Problems Inside the Product

Paper Jam Problems in the Cassette

Paper Jam Problems in the Duplexer (Rear Cover)

Where to Get Help

Related tasks
Checking for Software Updates

Related topics

Replacing the Ink Cartridge and Maintenance Box

Wi-Fi or Wired Networking
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Loading Paper

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Disconnect any interface cables connected to your product.
2. Make sure plain paper is loaded in Cassette 1.
3. Press the up or down arrow buttons, select Menu, and press the OK button.
4. Press the down arrow button, select Maintenance, and press the OK button.
You see this screen:

Maintenance
BPrint Head Nozzle Che

5. Select Print Head Nozzle Check.
You see a screen like this:

Print Head Mozzle C...
Frint a nozzle check p

&8 Yes & Mo

6. Press the up arrow button.
The nozzle pattern prints.
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7. Do one of the following, depending on the results of the product check:

+ If the page prints and the nozzle check pattern is complete, the product is operating properly. Any
operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

+ If the page prints but the nozzle check pattern has gaps, clean or align the print head.

+ If the page does not print, the product may have a problem. Check the other solutions in this
manual. If they do not work, contact Epson.

Parent topic: Solving Problems

Related concepts

Print Head Cleaning

Print Head Alignment

Uninstall Your Product Software

Related references
Where to Get Help

Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

Press the up or down arrow buttons, select Menu, and press the OK button.

2. Press the down arrow button, select System Administration, and press the OK button. Enter the
administrator password, if necessary.

3. Press the down arrow button, select Restore Default Settings, and press the OK button.
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You see this screen:

Restore Default Set...
Wi-Fi/Network Settings
elect item to restore

@D Proceed

4. Select one of these options:
* Wi-Fi/Network Settings: Resets all network settings.
» Clear All Data and Settings: Resets all control panel settings.
You see a confirmation screen.

5. Select the up arrow button to reset the selected settings. (Press the down arrow button if you want to
cancel the operation.)

Parent topic: Solving Problems

Solving Setup Problems

Check these sections if you have problems while setting up your product.

Noise After Ink Installation
Software Installation Problems

Parent topic: Solving Problems

Noise After Ink Installation
If you hear noises from your product after installing the ink cartridge, try these solutions:

» The first time you install the ink cartridge, the product must charge its print head. Wait until charging
finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on. Your product is finished charging the print head when the O power light stops flashing.

« If the product's print head stops moving or making noise, and the charging process has not finished
after 6 minutes, turn off your product. Turn it back on and check to see if charging is still in progress. If
it is still in progress, contact Epson for help.
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Parent topic: Solving Setup Problems

Software Installation Problems
If you have problems while installing your product software, try these solutions:

* Make sure your product is turned on and any necessary cables are securely connected at both ends. If
you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

» Close any other programs, including screen savers and virus protection software, and install your
product software again.

* In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

 If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your System Administrator.

Parent topic: Solving Setup Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
OS X System Requirements

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network

Product Does Not Appear in OS X Printer Window

Cannot Print Over a Network

Parent topic: Solving Problems
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Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected
Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the
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network connection or adapter settings in the Windows Control Panel and set the Internet metric
setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems

Related concepts
Wi-Fi Direct Mode Setup

Related tasks
Printing a Network Status Sheet
Selecting Wireless Network Settings From the Control Panel

Related topics
Wi-Fi or Wired Networking

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:

» Make sure your product is turned on and connected to your network. Verify connection using your
product control panel.

» Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-
ASCII characters.

* Make sure your product is not connected to a guest network.

* If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.
2. Windows only: uninstall your product software.
3. Initialize your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
initialize your router, so note the next step before initializing it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

+ If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
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Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in OS X Printer Window
If your product does not appear in the OS X printer window, try these solutions:
» Turn your product off, wait 30 seconds, then turn it back on again.

« If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon does not appear
on your product's LCD screen, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

* If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi icon does not appear
on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall
your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Cannot Print Over a Network
If you cannot print over a network, try these solutions:
* Make sure that your product is turned on.
» Make sure you install your product's network software as described in your product documentation.

» Print a network status sheet and verify that the network settings are correct. If the network status is
Disconnected, check any cable connections and turn your product off and then on again.
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If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your
network does not assign IP addresses using DHCP, set the IP address manually.

Make sure your computer and product are both using the same wireless network.

If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place
your product closer to your router or access point. Avoid placing your product near a microwave oven,
2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon does not appear
on your product's LCD screen, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing. If the link LED is off, try the following:

» Make sure the Ethernet cable is securely connected to your product and to your router, access
point, switch, or hub.

» Try connecting your product to a different port or a different router, access point, switch, or hub.
» Try connecting with a different Ethernet cable.
 Try printing to your product from another computer on the network.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear on the LCD,
make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related tasks

Printing a Network Status Sheet
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Related topics
Wi-Fi or Wired Networking

Solving Paper Problems
Check these sections if you have problems using paper with your product.

Paper Feeding Problems

Paper Jam Problems Inside the Product

Paper Jam Problems in the Cassette

Paper Jam Problems in the Duplexer (Rear Cover)
Paper Ejection Problems

Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:

+ If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust
the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette or rear feed slot.

» Be sure to insert the paper cassette all the way into your product.
« If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
* Do not load more than the recommended number of sheets.
» Make sure your paper meets the specifications for your product.
 If paper jams when you print on both sides of the paper, try loading fewer sheets.
» For best results, follow these guidelines:
» Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
* Load paper in the cassette printable side down.
» Do not load binder paper with holes in the cassette.
» Follow any special loading instructions that came with the paper.
Parent topic: Solving Paper Problems

Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Cassette
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Paper Jam Problems in the Duplexer (Rear Cover)
Paper Loading Capacity
Paper Specifications

Related topics
Loading Paper

Paper Jam Problems Inside the Product
If paper has jammed inside the product, follow the steps here to clear the jam.
1. Cancel the print job from your computer, if necessary.
2. Open the front cover.
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3. Remove any paper inside, including torn pieces.

4. Close the front cover.

S

5. If any jammed paper remains near the output tray, carefully remove it.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems in the Cassette
Paper Jam Problems in the Duplexer (Rear Cover)
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Paper Jam Problems in the Cassette
If paper has jammed in the cassette, follow the steps here to clear the jam.

1. Cancel the print job, if necessary.
2. Close the output tray.
3. Pull out the paper cassette.

-
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4. Carefully remove any paper jammed inside the product.

5. Carefully follow all paper loading instructions and reload the paper.
6. Keep the cassette flat as you gently insert it.
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7. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Duplexer (Rear Cover)

Paper Jam Problems in the Duplexer (Rear Cover)
If paper has jammed in the duplexer, follow the steps here to clear the jam.
1. Cancel the print job from your computer, if necessary.
2. Press the buttons on the sides of the rear cover and remove it.

3. Carefully remove any jammed paper.
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4. Remove any jammed paper from the duplexer.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems in the Cassette
Paper Jam Problems Inside the Product
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Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:

« If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.
Select the correct paper size when you reprint.

« If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select
the correct paper type setting when you reprint.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems Inside the Product

Paper Jam Problems in the Cassette

Paper Jam Problems in the Duplexer (Rear Cover)
Paper Type Settings - Control Panel

Related tasks
Cancelling Printing Using a Product Button

Related topics
Loading Paper

Solving PCL/PostScript Problems
Check these sections if you have problems with the PCL or PostScript printer software.

Nothing Prints Using the PCL/Postscript Printer Software
Settings Are Missing from the PCL or PostScript Printer Software

Parent topic: Solving Problems

Nothing Prints Using the PCL/Postscript Printer Software
If your document doesn't print, try these solutions:
» Make sure your product is turned on and properly connected.

» Check your product's control panel for error messages. The PCL and PostScript printing software will
not display any error messages on your computer screen if a printing error occurs.

» Make sure your product is selected as the printer in your printing program.
Parent topic: Solving PCL/PostScript Problems
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Settings Are Missing from the PCL or PostScript Printer Software
If certain settings are missing or incorrect in the PCL or PostScript printer software, try these solutions:
* Make sure your product is selected in the PCL printer software.

* If you are using the product as a laser printer replacement and have not installed Epson printer
software, certain options and functions may not be available. Install the standard Epson, PCL, or
PostScript printer software to access additional settings and features.

Parent topic: Solving PCL/PostScript Problems

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: For problems while printing with the Epson Universal Print Driver or PostScript (PS3) printer
software, see the sections covering that software in this manual.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow

Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
» Make sure your product is turned on.
» Make sure any interface cables are connected securely at both ends.

+ If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,
connect your product directly to your computer instead of the hub.

* Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

* In Windows, make sure your product is selected as the default printer.

* In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel and stalled print jobs.

Parent topic: Solving Problems Printing from a Computer
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Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:

1. Do one of the following:

* Windows 10: Right-clickn and select Control Panel > Hardware and Sound > Devices and
Printers.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers.
* Windows 7: Click E]' and select Devices and Printers.

* Windows Vista: Click E]' select Control Panel, and click Printer under Hardware and Sound.

» Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware, if necessary, and Printers and Faxes.)

2. Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

Click the Maintenance tab.
Click the Monitoring Preferences button.
Click the checkbox for the option that adds the shortcut icon to the taskbar.

o o bk w

Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Printing is Slow
If printing becomes slow, try these solutions:

* Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

+ If you are using Windows 7, close the Devices and Printers window before you print.
» Clear space on your hard drive or run a defragmentation utility to free up existing space.
» Close any programs you are not using when you print.
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* If your product is connected to a USB hub, connect it directly to your computer instead.

« If printing becomes slower after printing continuously for a long time, the product may have
automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:

* Make sure the paper type setting matches the type of paper you loaded.

» Turn on any high speed settings in your product software.

» Select a lower print quality setting.

* Make sure the ink drying time has not been increased for double-sided printing.

* Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,
and select the following settings:

+ Always Spool RAW Datatype
* Page Rendering Mode
* Print as Bitmap
Parent topic: Solving Problems Printing from a Computer

Related references

Paper Type Settings - Control Panel
Windows System Requirements

OS X System Requirements

Related tasks

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - OS X

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.
Inverted Image
Too Many Copies Print
Blank Pages Print

Incorrect Margins on Printout
Incorrect Characters Print
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Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
» Turn off any mirror or inversion settings in your printing application.

» Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer
software. (This option has different names, depending on your operating system version.)

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X

Too Many Copies Print

Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
» Make sure you selected the correct paper size settings in your printing program and printer software.

 If a blank page exists in a document you are printing and you want to skip printing it, select the Skip
Blank Page setting in your printer software.

* Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if
necessary.

» Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems
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Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related tasks

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Printing Preferences - OS X

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
» Make sure you selected the correct paper size settings in your printing program and printer software.
* Make sure you selected the correct margins for your paper size in your printing program.
» Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X

Related topics
Loading Paper

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
* Make sure any cables are securely connected at both ends.

* In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

* If your product is connected to a USB hub, connect it directly to your computer instead.
« Ifincorrect characters still appear in your prints, try connecting your product using a different cable.
Parent topic: Solving Page Layout and Content Problems
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Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:

* Make sure you selected the correct paper size and layout settings in your printing program and printer
software.

» Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Printing Preferences - OS X

Slanted Printout
If your printouts are slanted, try these solutions:
» Slide the edge guides against the edges of the paper.
» Select a higher print quality setting in your printer software.
» Turn off any high speed settings in your product software.
+ Align the print head.
» Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X

Related topics
Loading Paper

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

White or Dark Lines in Printout
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Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout

Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* Make sure the paper type setting matches the type of paper you loaded.

» Make sure you loaded the printable side of the paper correctly for your product.
» Turn off any high speed settings in your product software.

+ Align the print head.

* You may need to replace the ink cartridge.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references
Paper Type Settings - Control Panel

Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X

Related topics
Loading Paper
Replacing the Ink Cartridge and Maintenance Box

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
» Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
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* Use a support sheet with special paper, or load special paper one sheet at a time.

» Make sure your paper meets the specifications for your product.

» Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.

» Make sure the paper type setting in your product software matches the type of paper you loaded.
« If you are printing on thick paper or envelopes, make sure you select the appropriate settings.

* Remove each sheet from the output tray as it is printed.

» Turn off any high speed settings in your product software.

« If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily
saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

+ Align the print head.
* Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Cleaning
Print Head Alignment

Related references
Available Epson Papers
Paper Specifications

Related tasks

Cleaning the Paper Guide

Selecting Basic Print Settings - Windows

Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X

Selecting Printing Preferences - OS X

Selecting Double-sided Printing Settings - Windows
Selecting Double-sided Printing Settings - OS X
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Related topics
Loading Paper

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

» Theink cartridge may be old or low on ink, and you may need to replace it.

» Make sure the paper type setting matches the type of paper you loaded.

* Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
+ Align the print head.

* Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references
Paper Type Settings - Control Panel

Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Cleaning the Paper Guide

Related topics
Loading Paper
Replacing the Ink Cartridge and Maintenance Box

Grainy Printout
If your printouts are grainy, try these solutions:
» Make sure you loaded the printable side of the paper correctly for your product.
» Select a higher print quality setting and turn off any high speed settings in your product software.
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* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

+ Align the print head.

* You may need to increase the image resolution or print a smaller size; see your software
documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

+ If you enlarged the image in an image-editing program, you need to increase the resolution setting to
retain a high image quality. Increase the resolution by the same amount you increased the image size.
For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later,
change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related tasks

Selecting Basic Print Settings - Windows

Selecting Basic Print Settings - OS X

Selecting Additional Layout and Print Options - Windows

Related topics
Loading Paper

Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Printing Software - Standard Epson Printer Software - Windows
Uninstalling Product Software - OS X
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Parent topic: Solving Problems

Uninstalling Printing Software - Standard Epson Printer Software - Windows
You can uninstall and then re-install your printer software to solve certain problems.

Note: You cannot uninstall the PostScript printer software.

Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

* Windows 10: Right-click Iﬂ and select Control Panel > Programs > Programs and Features.
Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
Epson, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

4. Restart your computer, then re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.
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Parent topic: Uninstall Your Product Software

Uninstalling Product Software - OS X

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1.
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To download the Uninstaller utility, visit the Epson download site (U.S. downloads or Canadian
downloads).

Follow the instructions on the screen to install the Uninstaller utility.
Quit all applications currently running on your Mac.

Double-click the Uninstaller icon.

Select the checkbox for each software program you want to uninstall.
Click Uninstall.

Follow the on-screen instructions to uninstall the software.

Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the — (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.
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Speak to a Support Representative

Before you call Epson for support, please have the following information ready:
* Product name

* Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem

Then call:

* U.S.:(5662) 276-7202, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific
Time, Saturday

+ Canada: (905) 709-2567, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,
Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.
Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for
information on how to return your Epson products for proper disposal.

Windows System Requirements
OS X System Requirements
Paper Specifications

Printable Area Specifications
Ink Cartridge Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications

Network Interface Specifications
Safety and Approvals Specifications
PostScript Fonts

PCL Fonts

Symbol Sets

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 10

* Windows 8.x

* Windows 7

* Windows Vista

» Windows XP Professional x64 Edition
* Windows XP SP3

* Windows Server 2012R2
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* Windows Server 2012
* Windows Server 2008R2
* Windows Server 2008
* Windows Server 2003R2
* Windows Server 2003

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

OS X System Requirements
To use your product and its software, your Mac should use one of these operating systems:
+ OSX10.11.x
+ OS X10.10.x
+ OS X 10.9.x
+ OS X 10.8.x
+ OS X 10.7.x
+ 0SX10.6.8

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications
Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.
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Single-sheets

Size A4 (8.3 x 11.7 inches [210 x 297 mm])

A6 (4.1 x 5.8 inches [105 x 148 mm)])

Letter (8.5 x 11 inches [216 x 279 mm])

Legal (8.5 x 14 inches [216 x 356 mm])

4 x 6 inches (102 x 152 mm)

5 x 7 inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)

3.5 x 5inches (89 x 127 mm)

16:9 wide (4 x 7.1 inches [102 x 181 mm])

Half Letter (5.5 x 8.5 inches [140 x 216 mm])
Paper types Plain paper and paper distributed by Epson
Weight Plain paper: 17 Ib (64 g/m?) to 24 Ib (90 g/m?)

Thick paper: 25 Ib (91 g/m?) to 68 Ib (256 g/m?)

Envelopes

Size No. 10 (4.1 x 9.5 inches [105 x 241 mm])
Paper types Plain bond paper

Weight 20 1b (75 g/m?) to 24 Ib (90 g/m?)

Parent topic: Technical Specifications
Printable Area Specifications

Note: When printing borderless, quality may decline in the expanded printable area.
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Single sheets
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1 Top/bottom/sides: 0.12 inch (3.0 mm) minimum

2 Reduced print quality area/top: 1.77 inches (45.0 mm) minimum

3 Reduced print quality area/bottom: 1.97 inches (50.0 mm) minimum

Envelopes
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Sides: 0.12 inch (3.0 mm) minimum
Top/bottom: 0.20 inch (5.0 mm) minimum
Reduced print quality area/right: 0.71 inch (18.0 mm) minimum

A WODN -~

Reduced print quality areal/left: 1.77 inches (45.0 mm) minimum
Parent topic: Technical Specifications
Ink Cartridge Specifications

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.

The cartridge included with the printer is designed for printer setup and not for resale. After some ink is
used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Color Black

Cartridge life Opened package: 6 months
Unopened package: do not use if the date on the package has
expired

Temperature Storage: —4 °F (20 °C) to 104 °F (40 °C)

1 month at 104 °F (40 °C)
Ink freezes at 14 °F (—10 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Related references
Ink Cartridge and Maintenance Box Part Numbers

203



Dimension Specifications

Height Stored: 11.2 inches (284 mm)
Printing: 15.1 inches (383 mm)

Width Stored: 18.1 inches (461 mm)
Printing: 18.1 inches (461 mm)

Depth Stored: 16.6 inches (422 mm)
Printing: 25.8 inches (655 mm)

Weight 24.71b (11.2 kg)

(without ink cartridge and power

cord)

Parent topic: Technical Specifications

Electrical Specifications

Power supply rating 100 to 240 V

220t0 240V
Rated frequency range 50 to 60 Hz
Rated current 100t0240V:0.8t0 0.4 A

220t0240V: 04 A
Power consumption Printing: Approx. 25 W (ISO/IEC24712)
(100 to 120 V: with USB Ready mode: Approx. 6.2 W
connection)

Sleep mode: Approx. 2.3 W
Power off mode: Approx. 0.4 W

Power consumption Printing: Approx. 25 W (ISO/IEC24712)
(200 to 240 V: with USB Ready mode: Approx. 6.3 W
connection)

Sleep mode: Approx. 2.4 W
Power off mode: Approx. 0.4 W
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Parent topic: Technical Specifications

Environmental Specifications

Temperature Operating: 50 °F (10 °C) to 95 °F (35 °C)
Storage: -4 °F (—20 °C) to 104 °F (40 °C)
1 month at 104 °F (40 °C)

Humidity Operating: 20 to 80% RH

(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications

Interface type Hi-Speed USB (Device Class for computers)
Parent topic: Technical Specifications

Network Interface Specifications

Wi-Fi
Standards IEEE 802.11 b/g/n
Security WPA2-PSK (AES); complies with WPA2 standards with support for
WPA/WPA2 Personal
WPA2-Enterprise
WEP (64/128 bit)
Frequency band 2.4 GHz
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Communication mode

Ethernet

Standards

Communication mode

Connector

Security Protocol

Infrastructure mode
Ad hoc mode; not supported for IEEE 802.11n
Wi-Fi Direct; not supported for IEEE 802.11b

Note: Wi-Fi Direct Simple AP mode available even if you connect
the product to an Ethernet network.

IEEE802.3i (10BASE-T)
IEEE802.3u (100BASE-TX)

IEEE802.3ab (1000BASE-T); use a category 5e or higher STP
(shielded twisted pair) cable to prevent risk of radio interference

IEEE802.3az (Energy Efficient Ethernet); the connected device
should comply with IEEE802.3az standards

Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full
duplex, 100Mbps Half duplex

RJ-45

IEEE802.1X; connected device must be IEEE802.1X compliant

IPsec/IP Filtering

SSL/TLS: HTTPS Server/Client or IPPS

SNMPv3

Parent topic: Technical Specifications

Safety and Approvals Specifications

United States

Canada

Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B
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This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).

Parent topic: Technical Specifications

PostScript Fonts

Font name Family HP equivalent

Nimbus Mono Medium, Bold, Italic, Bold ltalic Courier

Letter Gothic Medium, Bold, ltalic, Letter Gothic

Nimbus Mono PS Regular, Bold, Oblique, Bold Courier PS
Oblique

Nimbus Roman No4 Medium, Bold, ltalic, Bold Italic |CG Times

URW Classico Medium, Bold, Italic, Bold Italic | CG Omega

URW Coronet — Coronet

URW Clarendon Condensed |— Clarendon Condensed

URW Classic Sans Medium, Bold, Italic, Bold lItalic Univers

URW Classic Sans Medium, Bold, Italic, Bold lItalic Univers Condensed

Condensed

Antique Olive Medium, Bold, Italic Antique Olive

Garamond Antiqua, Halbfett, Kursiv, Kursiv | Garamond
Halbfett

Mauritius — Marigold

Algiers Medium, Extra Bold Albertus

NimbusSansNo2 Medium, Bold, Italic, Bold Italic | Arial

Nimbus Roman No9 Medium, Bold, Italic, Bold Italic | Times New

Nimbus Sans Medium, Bold, Oblique, Bold Helvetica
Oblique
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Font name Family HP equivalent

Nimbus Sans Narrow Medium, Bold, Oblique, Bold Helvetica Narrow
Oblique

Palladio Roman, Bold, ltalic, Bold ltalic Palatino

URW Gothic Book, Demi, Book Oblique, Demi [ ITC Avant Garde
Oblique

URW Bookman Light, Demi, Light Italic, Demi ITC Bookman
Italic

URW Century Schoolbook Roman, Bold, ltalic, Bold ltalic New Century Schoolbook

Nimbus Roman Medium, Bold, ltalic, Bold Italic | Times

URW Chancery Medium lItalic [— ITC Zapf Chancery ltalic

Symbol — Symbol
URW Dingbats — Wingdings
Dingbats — ITC Zapf Dingbats

Standard Symbol — SymbolPS

Parent topic: Technical Specifications

PCL Fonts

Scalable Fonts

Font name Family HP equivalent Symbol set
Nimbus Mono Medium, Bold, ltalic, Bold |Courier 1
Italic
Letter Gothic Regular, Bold, Italic, Letter Gothic
Nimbus Mono PS Regular, Bold, Oblique, CourierPS 3
Bold Oblique
Nimbus Roman No4 Medium, Bold, ltalic, Bold |CG Times 2
Italic
URW Classico Medium, Bold, Italic, Bold [CG Omega 3
Italic
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Font name Family HP equivalent Symbol set

URW Coronet — Coronet 3

URW Clarendon — Clarendon Condensed 3

Condensed

URW Classic Sans Medium, Bold, ltalic, Bold | Univers 2
Italic

URW Classic Sans Medium, Bold, Italic, Bold |Univers Condensed 3

Condensed Italic

Antique Olive Medium, Bold, Italic Antique Olive 3

Garamond Antiqua, Halbfett, Kursiv, |Garamond 3
Kursiv Halbfett

Mauritius — Marigold

Algiers Medium, Extra Bold Albertus

NimbusSansNo2 Medium, Bold, ltalic, Bold | Arial
Italic

Nimbus Roman No9 Medium, Bold, ltalic, Bold | Times New 3
Italic

Nimbus Sans Medium, Bold, Oblique, Helvetica 3
Bold Oblique

Nimbus Sans Narrow | Medium, Bold, Oblique, Helvetica Narrow 3
Bold Oblique

Palladio Roman, Bold, ltalic, Bold |Palatino 3
Italic

URW Gothic Book, Demi, Book ITC Avant Garde 3
Oblique, Demi Oblique

URW Bookman Light, Demi, Light Italic, ITC Bookman 3
Demi ltalic

URW Century Roman, Bold, Italic, Bold |New Century Schoolbook 3

Schoolbook Italic

Nimbus Roman Medium, Bold, ltalic, Bold |Times 3

Italic
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Font name Family HP equivalent Symbol set
URW Chancery — ITC Zapf Chancery ltalic 3
Medium ltalic

Symbol — Symbol 4
URW DingBats — Wingdings 5
Dingbats — ITC Zapf Dingbats 6
Standard Symbol — SymbolPS 4
URW David Medium, Bold HP David 7
URW Narkis Medium, Bold HP Narkis Tam 7
URW Miryam Medium, Bold, Italic HP Miryam 7
URW Koufi Medium, Bold Koufi 8
URW Naskh Medium, Bold Naskh 8
URW Ryadh Medium, Bold Ryadh 8
Bitmap Font

Line Printer, Symbol set 9

OCR/Barcode Bitmap Font (PCL5 Mode Only)

Font name Family Symbol set
OCRA — 10

OCRB — 11

Code 39 9.37cpi, 4.68cpi 12
EAN/UPC Medium, Bold 13

Note: Depending on the print density or quality and color of the paper, the OCR/Barcode Bitmap fonts

may not be readable. Print a sample and check for readability before printing large quantities.

Parent topic: Technical Specifications
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Symbol Sets

Your product can access a variety of symbol sets. Many of these symbol sets differ only in the
international characters specific to each language.

Note: Since most software handles fonts and symbols automatically, you may never need to adjust your
product settings. However, if you write your own product control programs, or if you use older software
that cannot control fonts, refer to these tables for details on the symbol sets.

When you consider which font to use, also consider which symbol set to combine with the font. Available
symbol sets vary depending on the mode and font you choose.

PCL5 Mode Symbol Sets

Symbol set | Attribu | Font classification

name te Iy J2 3 [a s [6 [7 [8 Jo [10 [11 [12 [13
ISO60: (0D v v v - - |- |- |- |- |— |- |— |-
Danish/Nor

wegian

Roman |[0OE |— |— |— |— |— |— |[— |[— v |— |[— [|— [|—
Extension

Iso1s5: ot |V |V IV O |— |- |- |- |- |- |- |- |- [|—
Italian

ISO 8859/1 [ON v v v o= - |- |- |- |V |- |- |- |-
Latin 1

ISO11:  |0S v v v - - |- |- |- |- |- |- |- |-
Swedish

ISO 6: ouU v v v o= - - v IV |- |- |- |— |-
ASCII

ISO 4: 1E v v v - - |- |- |- |- |— |- |— |-
United

Kingdom

ISO69: |1F v v v - - |- |- |- |- |— |- |— |-
French
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Symbol set | Attribu | Font classification

name © 1 |2 [3 |4 9 |10 |11 |12 |13
ISO 29: 1G v V|V — - = |= |= |=
German

Legal 1U v VvV | — v o= = [— |=
ISO 8859/2 | 2N v V|V — v = |— = |[—
Latin 2

ISO 8859/4 |4N v V|V — — = |= |= [|=
Latin 4

ISO 17: 2S v V|V — — = |= |= [|=
Spanish

Roman-9 |4U v V|V — — = = = |=
PS Math 5M v VvV — _ = = = =
ISO 8859/9 | 5N v VvV | — v |- |- |— |-
Latin 5

Windows [5T v V|V — _ = = = |=
3.1 Latin 5

Microsoft |6J v V|V — _ = = = |=
Publishing

Ventura 6M v V|V — _ = = = |=
Math

ISO 6N v VvV | — v |- |- |— |-
8859/10

Latin 6

DeskTop 7J v VvV | — — = = = |=
Math-8 8M v Vv V= - = = = [=
Roman-8 8U v VvV | — v = = |— |—
Windows 9E vi |V OV | — _ = = = =
3.1 Latin 2

Pc1004 9J v VvV |— - = = = =
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Symbol set | Attribu | Font classification

name e 1 |2 |3 |4 9 (10 [11 [12 [13
ISO 9N v Vv V= v = |— |— |[—
8859/15

Latin 9

PC-8 9T v Vv V= —_ = = = [|—
Turkish

Windows [9U v V|V — _ = = = |=
3.0 Latin 1

PS Text 10J v VvV |— _ = = = |=
PC-8, Code | 10U v VvV = v |- |— |— |—
Page 437

PC-8 D/N 11U v VvV = v = |— = |[—
Danish/Nor

wegian

MC Text 12J v VvV = —_ = = = [|—
PC-850 12U v VvV = v |- |— |— |[—
Multilingual

Ventura 13J v VvV | — — = = = =
Internationa

I

PcEur858 [13U v VvV = _ = = = [|—
Ventura US [14J v VvV | — — = = = |=
Pi Font 15U v VvV | — — = = [= |=
PC852, 17U v VvV | — - = = |= [|=
Latin 2

Unicode 3.0 | 18N v VvV | — — = = = |=
Windows 19L v |V V | — _ = = = =
Baltic
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Symbol set | Attribu | Font classification

name e 1 [2 [3 Ja 7 10 [11 |12 [13
Windows 19U v VvV | — — — = 1= =
3.1

Latin/Arabic

PC-755 26U v Vv V= — = = =
PC-866, 3R v, |V |— |— — — = = =
Cyrillic

Greek8 8G v, |V |— |— — — = = =
Windows 9G v, |V |— |— — — = = =
Greek

Windows 9R v, |V |— |— — — = = =
Cyrillic

PC-851, 10G v |V |— |— — — = = =
Greek

ISO 8859/5 | 10N v Vv = = — — = = [|—=
Cyrillic

PC-8, 12G v |V |— |— — — = = =
Greek

ISO 8859/7 | 12N v Vv = = — — = = [|—=
Greek

PC-866 14R v Vv = = — — = = [|—=
UKR

Hebrew7 OH v |— |— |[— v — = = |=
ISO 8859/8 | 7H v |- |- |— v’ — = = [|—=
Hebrew

Hebrew8 8H v |- |- |— v - |= = [=
PC-862, 15H v, |— |[— |— v — = = =
Hebrew

PC-862, 15Q v, |— |— |— v — = = [|—=
Hebrew
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Symbol set | Attribu | Font classification

name © 1 |2 [3 |4 8 10 (11 [12 [13
Arabic8 8V — = = |[— v — = = |[—
HPWARA |9V — = |—= |[— v — = = |—=
PC-864, 10V — = |— |[— v — = = |—=
Arabic

Wingdings |579L — = = |— — - |= = |=
Symbol 19M — = = |V — — |= |= |—=
ZapfDingba | 14L — |—= = |— — — = = [|=
ts

OCRA 00 — = = |[— — v |- |— |-
OCRB 10 — = = |[— — — |V = |—
OCRB 3Q — = = |- — — v |= |-
Extension

Code3-9 oY - |- = |- — — |- |V |-
EAN/UPC |8Y — = |—= |[— — — |—= = |V
PCL6 Mode Symbol Sets

Symbol set Attribute |Font classification

name 1 2 3 7 3

ISO Norwegian | 4 v v v — _ _
ISO ltalian 9 v v v — _ _
ISO 8859-1 14 v v v — — v
Latin 1

ISO Swedish |19 v v v — — —
ASCII 21 v v v v v —
ISO United 37 v v v — _ _
Kingdom
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Symbol set
name

Attribute

Font classification

ISO French

38

ISO German

39

Legal

53

ISO 8859-2
Latin 2

78

ISO Spanish

83

Roman-9

149

PS Math

173

ISO 8859-9
Latin 5

174

Windows 3.1
Latin 5

180

Microsoft
Publishing

202

ISO 8859/10
Latin 6

206

DeskTop

234

Math-8

269

Roman-8

277

Windows 3.1
Latin 2

293

Pc1004

298

ISO 8859-15
Latin 9

302

PC-Turkish

308

Windows 3.0

309

PS Text

330

ANANANERN AN ERN AN AN AN EEN BN BN BN AN AN AN ERNAN AN AN I
ANANA YR YA NERNANANANERN BN BN BN AN AN AN RN AN AN AN L
ANANANERN AN ERNAN AN AN ERN BN BN RN AN AN AN ERN AN AN AN by
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Symbol set
name

Attribute

Font classification

PC-8

341

PC-8 D/N

373

NIN€@

MC Text

394

PC-850

405

N

PcEur858

437

Pi Font

501

PC852

565

Unicode 3.0

590

WBALT

620

Windows 3.1
Latin 1

629

PC-755

853

Wingdings

18540

Symbol

621

ZapfDingbats

460

PC-866,
Cyrillic

114

Greek8

263

Windows
Greek

295

Windows
Cyrillic

306

PC-851, Greek

327

ISO 8859/5
Cyrillic

334

PC-8, Greek

391

1 2 3
v oo v
v v v
v v v
v o v v
v lvo v
vl v
v v v
v v v
v v v
v o v v
v o v v
v v =
v v =
v v =
v v =
v v =
v v =
v v =
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Symbol set Attribute |Font classification

name 1 2 3 - 3
ISO 8859/7 398 v v — — —
Greek

PC-866 UKR [466 v v — — —
Hebrew7 8 v — — v —
ISO 8859/8 232 v — — v —
Hebrew

Hebrew8 264 v — — v _
PC-862, 488 v — — v —
Hebrew

Arabic8 278 — — — — v
HPWARA 310 — — — _ v
PC-864, Arabic | 342 — — — — v

Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for
information on how to return your Epson products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Trademarks

Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.

General Printer Safety Instructions

Ink Cartridge Safety Instructions

LCD Screen Safety Instructions
Wireless Connection Safety Instructions

Parent topic: Notices

General Printer Safety Instructions
* Be sure to follow all warnings and instructions marked on the printer.
* Use only the type of power source indicated on the printer's label.

» Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do
not use the cord with any other equipment.

* Place the printer near a wall outlet where the plug can be easily unplugged.

» Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that
regularly switches on and off, or on an outlet controlled by a wall switch or timer.

* Do not let the power cord become damaged or frayed.

+ If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged
into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere
rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.
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Always turn off the printer using the power button, and wait until the power light stops flashing before
unplugging the printer or cutting off power to the electrical outlet.

Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

Make sure the back of the printer is at least 4 inches (10 cm) away from the wall.

Leave enough space in front of the printer for the paper to be fully ejected.

Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
Do not place the printer near a radiator or heating vent or in direct sunlight.

Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the
case or insert objects through the slots.

Keep the printer away from potential sources of electromagnetic interference, such as loudspeakers or
the base units of cordless telephones.

When connecting the printer to a computer or other device with a cable, ensure the correct orientation
of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong
orientation may damage both devices connected by the cable.

Do not touch the flat white cable inside the printer.
Do not move the print head by hand; this may damage the printer.
Do not spill liquid on the printer.

Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may
cause fire.

Except as specifically explained in your documentation, do not attempt to service the printer yourself.

Unplug the printer and refer servicing to qualified service personnel under the following conditions: if
the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in
the plug, make sure you replace them with fuses of the correct size and rating.

Leave the ink cartridge installed. Removing the cartridge can dehydrate the print head and may
prevent the printer from printing.

Before transporting the printer, make sure that the print head is in the home (far right) position and the
ink cartridge is in place.
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* When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down;

otherwise ink may leak.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

Keep ink cartridges out of the reach of children and do not drink the ink.

Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

Do not put your hand inside the product or touch any cartridges during printing.

Install a new ink cartridge immediately after removing an expended one. Leaving cartridges
uninstalled can dry out the print head and may prevent the product from printing.

Do not remove or tear the label on the cartridge; this can cause leakage.

Do not remove the transparent seal from the bottom of the cartridge. This may cause the cartridge to
become unusable.

Do not break the hooks on the side of the cartridge when removing it from the packaging.
Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
Do not shake cartridges after opening their packages; this can cause them to leak.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in
the same environment as the product. Note that there is a valve in the ink supply port, making covers
or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge
touches. Do not touch the ink cartridge ink supply port or surrounding area.

Use an ink cartridge before the date printed on its package.
Do not dismantle an ink cartridge. This could damage the print head.
Store ink cartridges in a cool, dark place.

After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature
for at least three hours before using it.

Store ink cartridges with their labels facing upward. Do not store cartridges upside down.

Parent topic: Important Safety Instructions

LCD Screen Safety Instructions

Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
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+ If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash
them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

* Do not press too hard on the LCD screen.
» Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
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equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

CAN ICES-3(B)/NMB-3(B)

Parent topic: Notices

Trademarks

EPSON?® s a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson
Connect™ is a trademark of Seiko Epson Corporation.

Epson Store®™ is a service mark of Epson America, Inc.
Epson iPrint™ and Remote Print™ are trademarks of Seiko Epson Corporation.

Apple, App Store, iPhone, Mac, and OS X are trademarks of Apple Inc., registered in the U.S. and other
countries.

Google® is a registered trademark and Android™, Chromebook™, Google Chrome™, Google Cloud
Print™, and Google Play™ are trademarks of Google Inc.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.

General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON

EXCEED YOUR VISION

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
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Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

Parent topic: Notices

libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (1) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice
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A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution
© 2016 Epson America, Inc.
3/16
CPD-50908R1
Parent topic: Copyright Notice
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